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Documentation Updates 

This guide’s title page contains the following identifying information: 

• Software Version number, which indicates the software version 

• Document release date, which changes each time the document is updated 
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Support 

You can visit the HP Software support web site at: 

www.hp.com/managementsoftware/services 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.  

HP Software online software support provides customer self-solve capabilities. It provides a 
fast and efficient way to access interactive technical support tools needed to manage your 
business. As a valued support customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest


• Submit and track support cases and enhancement requests 


• Download software patches 


• Manage support contracts 


• Look up HP support contacts 


• Review information about available services 


• Enter into discussions with other software customers 


• Research and register for software training


Most of the support areas require that you register as an HP Passport user and sign in.

Many also require a support contract.


To find more information about access levels, go to: 


www.hp.com/managementsoftware/access_level 

To register for an HP Passport ID, go to:  

www.managementsoftware.hp.com/passport-registration.html 
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1 Introduction 
After a period of time, a computer starts to reflect the personality and choices 
of the person using it. For example, e-mail, application settings, browser 
settings and favorites, custom Word dictionaries, and many other settings are 
reflected in the overall state of the computer. Until now, most of this data or 
personality was lost when switching computers or upgrading to a new 
operating system. 

CM Settings Migration Manager captures computer personalities, keeps 
them organized, and then allows these personalities to be injected into a new 
computer. CM Settings Migration Manager also has the capability of 
performing personality backups and restoring individual files contained in a 
personality.  
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What is a Computer Personality? 
The components that define a computer personality comprise both the end-
user’s and the company’s customization choices. These include the desktop 
interface, e-mail, application settings, and the user’s documents and data 
files. 

The Desktop Interface 

The Windows operating system is rich with options that allow users to 
personalize their environments. These include wallpaper, sounds, display 
settings, shortcuts, and much, much more. In short, the Desktop Interface 
defines how users interact with their computers and is a key component in 
user productivity. 

Application Settings 

The applications used on a daily basis offer thousands of choices for 
customization. Not capturing, transferring, or backing up these settings 
means that the user must reconfigure the new computer. 

Internet and Email 

Many aspects of business are now routinely handled on the Internet through 
web browsers and e-mail. Internet-related computer personality items 
include browser settings, address books, e-mail settings and folders, 
newsgroup settings, bookmarks, remote access settings, and so forth. 

Documents and Data Files 

Locating and transferring files during a migration has traditionally been very 
difficult. 

Compounding the problem is the fact that some applications store data files 
in obscure locations. CM Settings Migration Manager provides extensive 
built-in support for locating and migrating most common application data 
files. 
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Additionally, File Rules technology gives the user advanced capability to 
locate all additional documents and files and ensure their migration. See 
Chapter 6, Using File and Registry Rules for details. 

CM Settings Migration Manager also works well with stand-alone 
computers, either by temporarily networking or connecting the source 
and target computers directly through their network, serial, parallel 
or USB ports, or a similar connection to an intermediate, portable 
computer. Personalities can even be extracted to and injected from 
removable media, provided the personality data fits on the media unit 
(disk, tape, and so forth). 

CM Settings Migration Manager Supported 
Applications and Settings 

For detailed Application settings and data support for CM Settings Migration 
Manager see Appendix C, Application Support Notes. 

Microsoft Office Supported Applications 

• Microsoft Access  95, 97, 2000, XP, 2003, 2007 

• Microsoft Excel  95, 97, 2000, XP, 2003, 2007 

• Microsoft FrontPage  2000, XP, 2003, 2007 

• Microsoft Groove 2007 

• Microsoft InfoPath  2003, 2007 

• Microsoft OneNote  2003, 2007 

• Microsoft Outlook  (Windows Messaging), 97, 98, 2000, XP, 2003, 2007 

• Microsoft PowerPoint  95, 97, 2000, XP, 2003, 2007 

• Microsoft Project  98, 2000, 2002, 2003, 2007 

• Microsoft Publisher  2003, 2007 

• Microsoft Word  95, 97, 2000, XP, 2003, 2007 
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Other Supported Applications 

• Act! 2000 

• Adobe Acrobat  4.x, 5.x, 6 

• Acrobat Reader  4.x. 5.x, 6, 7 

• MSN Messenger 7.0, 7.5 

• Yahoo Messenger 7.0, 7.5, 8 

• Lotus Notes 5.x, 6.x 

• Microsoft Internet Explorer  4.01, 5.x, 6.x, 7.x 

• Microsoft NetMeeting  2.x, 3.x 

• Microsoft Outlook Express  5.x, 6.x 

• Mozilla Firefox 1.x, 2.x 

• Netscape  4.5, 4.6, 4.7, 6.x 

• Norton AntiVirus 2000 

• Norton AntiVirus Corporate Edition 

• Visio  2000, 2002, 2003, 2007 

• WinZip  7.x, 8.x, 9.0 

• WordPerfect Office 2000 

— Corel Utilities 

— Dragon NaturallySpeaking for WordPerfect 

— Quattro Pro 9 

— WordPerfect 9 

Windows Options 

• Desktop Shortcuts 

• Dial-Up Networking 

• Folder Options 

• Local Printer Logging 

• Mapped Network Drives 
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• Network and Shared Printer Connections 

• Taskbar and Start Menu 

— Quick Launch Bar Shortcuts 

— Taskbar and Start Menu Settings 

• User Documents and Media Files 

— My Documents 

— My Pictures 

— My Music 

— My Videos 

• Windows Address Book 

Control Panel (Settings) 

• Accessibility Options 

• Display 

— Appearance and Themes 

— Background 

— Visual Effects 

• Internet Options 

• Keyboard 

— Keyboard Languages 

— Keyboard Settings 

• Mouse Settings 

— Buttons and Motions 

— Pointers and Schemes 

• Power Management 

• Regional Settings 

• Sounds 

• Time Zones 
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The Advantages of CM Settings Migration Manager 
These Hewlett-Packard products are based on technology that extracts, 
stores, and transfers a computer personality from one computer to another. 
At the core of the technology is the personality engine. This unique 
technology interfaces directly with core OS components, shielding the user 
from highly complex, low-level tasks such as registry manipulation. The 
personality engine is capable of capturing and transferring nearly anything 
that can be stored in a persistent manner on a computer. This inherent 
flexibility means the personality engine will be able to keep pace as new 
operating systems and applications are developed. 

HP also provides a mechanism to describe application or operating system 
configuration information. This configuration content feeds the personality 
engine with information on specific applications and operating system 
settings. 

Using CM Settings Migration Manager with Disk Imaging 

Software


CM Settings Migration Manager can be used alongside disk imaging software 
in a corporate environment involving upgrades of multiple PCs. Disk imaging 
software is designed to create baseline images for standard desktops from a 
master disk image that typically is comprised of an operating system and 
standard applications. 

Disk imaging software duplicates this entire master disk on the target 
computer, but is incapable of transferring the computer personality from the 
user’s original PC. 

Moving Applications in a PC Migration 

CM Settings Migration Manager does not move applications from one 
machine to another. Instead, it moves the settings and data files of those 
applications. Directly copying applications between machines is not advisable 
for a number of reasons: 

1	 Copying files is only the tip of the iceberg in installing an application, 
with the majority of the work actually requiring intense interaction with 
the operating system to register the application and its resource 
requirements. 
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2	 Implementing a partial installationby copying the applications can often 
result in unstable systems that, in many cases, can only be rectified by a 
complete re-imaging process. 

3	 Microsoft has issued statements against circumventing standard 
operating system installation protocol and indicates that systems 
configured with such applications are, in effect, unsupportable. 
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2 Migration Overview 
This chapter contains points to consider when you plan a migration project 
with CM Settings Migration Manager. Next, we present the general steps for 
use of the program. Following that, to provide a background for various uses 
of the program, we illustrate three common scenarios for the use of CM 
Settings Migration Manager. Topics include the best ways to use the program 
in a networked environment, a direct, computer-to-computer scenario, and 
considerations for mixed environments. Advantages of CM Settings 
Migration Manager’s flexibility and options in meeting the requirements of 
nearly any environment are highlighted. 
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Migration Project Considerations 
Examining the basic requirements of a migration project and your available 
resources can help determine the best approach for a given situation. 

1	 How many computers are involved? 
CM Settings Migration Manager can be used for the replacement of a 
single PC, as well as in a mass migration involving hundreds or even 
thousands of computers. 

2	 Are the computers in a network environment or a non-network 
environment? 

3	 The two conditions are very different in terms of time and media 
requirements. 

4	 Will a drive-imaging product be used alongside CM Settings Migration 
Manager to prepare new computers with a base operating system image 
and common corporate applications? 
CM Settings Migration Manager is flexible enough to work with any 
drive-imaging product. 

5	 Extracted data can take up a lot of space if user data files are included. 
Where will the extracted personalities be stored? Will multiple computer 
personalities be extracted and then injected at a later time? Or will each 
extraction be followed immediately by an injection on to the new 
computer? 

6	 How many technicians will be involved? 
The more technicians required, the more important a plan becomes to 
avoid confusion and assure consistent results. Using multiple CM 
Settings Migration Manager Configuration files provides flexibility to 
maximize productivity. 

Using CM Settings Migration Manager on a 
Network 

In a networked environment, the benefits of CM Settings Migration Manager 
are best realized if the product is installed to individual computers from a 
common network location. This automatically establishes a common location 
for personalities. It is important to ensure this location is available to all 

24	 Chapter 2 



computers participating in the migration project. There must be enough disk 
space available for the extracted personality data. 

Extraction and Injection Flexibility 
You have several choices for storing personalities after they are extracted: 

• Removable media 

• File server 

• Local drive 

• USB Hard Drive 

Using CM Settings Migration Manager One-on-One 
Migrating personalities directly from one computer to another in a non-
network environment is essentially the same as migrating in a networked 
environment. If two computers cannot be physically connected to each other, 
use a USB Hard Drive or removable media to store and transfer the extracted 
personality. 

If two computers can be physically connected with a serial, parallel, or USB 
cable, the extracted personality can be transferred from the source to the 
target computer using that connection. 

Migrating Users that are not the Currently Logged In 
User 

CM Settings Migration Manager can be used to either migrate the 
personality of the currently logged in user, or migrate the personality of users 
that are not currently logged in, but have user profiles on the computer. 
Migrating users that are not logged in at the time of extraction or injection 
can be performed using CM Settings Migration Manager automation, or from 
the CM Settings Migration Manager user interface. 
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To extract or inject a personality for a user that is not currently 
logged in to the machine, the user that is performing the extraction or 
injection must have local administrator rights. Also note that CM 
Settings Migration Manager requires elevated administrator 
privileges when running on Windows Vista. 

Multi-Profile Environments 
Some corporate environments take advantage of multiple profiles on single 
computers to facilitate computer sharing. CM Settings Migration Manager 
can be used to migrate multiple user profiles from the CM Settings Migration 
Manager user interface, or by utilizing CM Settings Migration Manager's 
automation capabilities. See Chapter 8, Command Line Interface for more 
information on CM Settings Migration Manager automation. 

CM Settings Migration Manager and Disk Partitions 
CM Settings Migration Manager supports PCs that have multiple Windows 
partitions. When moving files CM Settings Migration Manager uses the 
following rules: 

1	 All requested files are extracted from the fixed drives of the source 
computer. 

2	 During injection, CM Settings Migration Manager first looks to see if the 
drive letter exists on the target system. If so, the file is moved to that 
location. If the requested directory associated with that file does not yet 
exist, CM Settings Migration Manager creates it before injecting the file. 

3	 If the drive letter does not exist on the target computer, then CM Settings 
Migration Manager creates a MIGRATED_ x_ DRIVE directory at the root 
of the target system’s C drive where x is the drive letter from which the 
file was extracted. The file (and its corresponding directory structure) is 
copied to this directory. 
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Examples for Directory Creation and Drive Letter Recognition 

Example 1 

C:\specialdocs\codeblue\highlights.doc will be migrated from 
Computer A to Computer B. Computer B has one disk partition, C. CM 
Settings Migration Manager migrates highlights.doc to 
C:\specialdocs\codeblue on Computer B, creating the necessary directory 
structure if it doesn’t already exist. 

Example 2 

D:\userfiles\old \report.html will be migrated from Computer A to 
Computer B. Computer B has two partitions, C and D. CM Settings 
Migration Manager migrates report.html to D:\userfiles\old on 
computer B, creating the necessary directory structure if it doesn’t already 
exist. 

Example 3 

E:\userfiles\old \report.html will be migrated from Computer A to 
Computer B. Computer B has two partitions, C and D. CM Settings 
Migration Manager creates C:\MIGRATED_E_DRIVE on computer B and places 
\userfiles\old\report.html in that newly created directory since an E 
partition does not exist on the target. 

Printer Considerations 
CM Settings Migration Manager migrates settings for network printers, and 
the identity of local printers so that the proper drivers can be installed. Local 
printer drivers must be installed individually on target computers. 

Migrated network printers appear as reconnect icons on the desktop. Clicking 
on a reconnect icon attempts to connect to the printer using the standard 
Windows installation routine for your operating system. 
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3	 Extracting using CM Settings 
Migration Manager 

This chapter introduces Configuration files, templates, and the Data Store. 
Also included is a step-by-step extraction tutorial demonstrating how to 
create a Data Store and select which elements of a personality are extracted 
using the extraction template. 
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Extraction Overview 
To perform an extraction: 

1	 Use the Browse and Select buttons to set the location for the Data Store 
if a location other than the default is desired. A configuration file other 
than the default can also be selected. 

2	 Select whether you want to migrate the personality of the user that is 
currently logged in, or one or more of the other users from the User(s) to 
Extract tab. 

3	 CM Settings Migration Manager supported personality objects are listed 
in the Select for Extraction window. By default, all personality object 
boxes are unchecked. Select the personality objects desired by clicking the 
associated check boxes. 

4	 If you are migrating personalities from tens, hundreds, or thousands of 
computers, you may want to create a customized configuration to help 
implement a consistent process and set of standard policies. Make your 
configuration selections and changes, then simply save the configuration 
file if you want to use this same configuration for several personality 
migrations. 

5	 When satisfied with the extraction setup, click Begin Extraction. A 
progress and status dialog displays. When finished, click OK to display 
the log file and return to the Extraction View. 

Configuration Files 

Understanding Configuration files and how they are used is important when 
configuring CM Settings Migration Manager for a migration. The actual 
contents of a configuration file are straightforward. It contains the location of 
the Data Store, the location of the default Extraction template, File Rules, 
policy selections, and the log file detail level. Multiple Configuration files can 
be created and associated with different departments, buildings, 
organizations, or any other group. 

When the configuration file is saved, it automatically saves any personality 
objects that have been selected in the Select for Extraction window. Saving 
the CM Settings Migration Manager configurations to be used for future 
migrations eliminates the manual selection of personality objects for each 
individual computer to be processed, which can save a good deal of time on a 
major project. 
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The Data Store 

The Data Store is where CM Settings Migration Manager stores extracted 
personalities and where it looks for personalities to inject. In a network 
environment, it makes sense to designate a common location on a server as 
the Data Store. If desired, a different Data Stores can be maintained (by 
having different configuration files) to simplify the storage and retrieval of 
personalities. 

In a peer-to-peer network, the computer the data is extracted from can 
actually be used as the Data Store. Conversely, the target computer can also 
serve as the Data Store. For stand-alone computers, the Data Store is 
typically on the local drive of the computer. In all cases, the Data Store must 
eventually be accessible to both the source and target computers. 

File Rules 

The File Rules functionality of CM Settings Migration Manager intelligently 
scans for and moves files based on parameters to include or exclude files by 
path, type, date and size, and file extension. Rules are specified in the Edit → 
File Rules dialog box and are saved when the Configuration file is saved. See 
Chapter 6, Using File and Registry Rules for more details on this feature. 

Log File Detail Level 

CM Settings Migration Manager keeps a log of activity during extraction and 
injection. The level of detail in the log file is specified in the Edit → 
Preferences → Log File dialog box and is saved in the configuration file. See 
Chapter 5, OV Setting Migration Manager Interface for more details on this 
feature. 

Configuration File Search Rules 

CM Settings Migration Manager looks in the current directory for a 
configuration file named se.cfg. In a network environment, the current 
directory is the Sharepoint Setup directory established in Step 1 of the 
installation (see Chapter 1, Introduction). If the configuration file was saved 
with a different name CM Settings Migration Manager will still look for a file 
se.cfg. If that file is not found, a default will be created. 
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Before Running CM Settings Migration Manager on a PC to Be 
Extracted 

• Run a virus scan of the computer ’s entire system. 

• Remove any unwanted files and directories. 

• Run Scan- Disk. 

• Close any open applications and background processes (this is required). 

Extract Personality View 

On the Data Store option line, click Browse and then select the location of 
the Data Store if a location other than the default is desired. 

Figure 1 Browse for folder 

By default, no items in the extraction template are checked for inclusion. 
Include items by clicking the box next to the item to place a check mark in 
the box. If desired, click the respective checkbox again to clear specific items: 
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Figure 2 Select resources to migrate 

If a general, custom template is used for many computers, be aware that for 
each item that is selected, CM Settings Migration Manager will perform a 
drive scan on the system checking for the existence of the data files or data 
settings for that particular item. Selecting only those items that are specific 
to your environment will allow for better performance. 

After the Extraction template is set, click Extract at the bottom right of the 
screen: 

When the extraction is complete, a successful extraction message appears. 

The log file is also displayed when the extraction is complete. 
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If you are performing an extraction or injection of the currently logged 
in user's personality, the logged in user must have full access to the 
local file system, and full access to the registry hives of HKEY_USERS, 
HKEY_CURRENT_USERS, and HKEY_LOCAL_MACHINE. 

To extract or inject a personality for a user that is not currently 
logged in to the machine, the user that is performing the extraction or 
injection must have local administrator rights. Also note that CM 
Settings Migration Manager requires elevated administrator 
privileges when running on Windows Vista. 
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4	 Injecting Using CM Settings 
Migration Manager 

This chapter shows you how to streamline the injection process using 
configuration files. A step-by-step injection tutorial is also included. 
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Injection Overview 
Now that the data are extracted to the Data Store, they can be injected into a 
target computer. The first step is to open CM Settings Migration Manager 
and switch to the Injection View by clicking the Inject Personality icon on the 
left side of the window. 

Select an alternate Data Store location other than the default by clicking 
Browse. This will open the Browse for Folder dialog box. Select the desired 
data store location and click OK. 

Figure 3 Browse for folder 
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Data Store selection is not required if both the source and target 
computers installed CM Settings Migration Manager from the same 
network location and are using the default Data Store location. 
If you are performing an extraction or injection of the currently logged 
in user's personality, the logged in user must have full access to the 
local file system, and full access to the registry hives of HKEY_USERS, 
HKEY_CURRENT_USERS, and HKEY_LOCAL_MACHINE. 
To extract or inject a personality for a user that is not currently 
logged in to the machine, the user that is performing the extraction or 
injection must have local administrator rights. Also note that CM 
Settings Migration Manager requires elevated administrator 
privileges when running on Windows Vista. 

Extracted personalities appear, listed in the Personalities drop-down box as 
shown below: 

Figure 4 Select personality to inject 

Select a personality from the Personalities drop-down box. The lock icon 
beside a personality means it has been password protected. 

Application data associated with a personality displays in the Select for 
Injection window. Include or exclude applications by checking the personality 
object’s check box. When satisfied with the injection setup, click Inject. 
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Figure 5 Select component to inject 

After the injection process starts, it should not be interrupted. The successful 
injection message appears when injection is complete: 

After you click OK, the log file is displayed in a dialog box. 
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5	 OV Setting Migration Manager 
Interface 

CM Settings Migration Manager was designed with ease of use in mind so 
common functions and repetitive operations are easily accessible. The CM 
Settings Migration Manager user interface contains menus, toolbars, a 
process bar and an active process area. 
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Figure 6 Settings Migration Manager configuration window 

Legend 

a Menus — Standard Windows drop-down menus provide access to Settings Migration 
Manager functions. 

b Toolbar — Located below the menus, this area provides one-click access to the most 
commonly used functions. 

c Process bar — Icons for extraction, injection, incremental backup, and restoration of 
files are here. Click an icon to select a process. 

d Status bar — Contains the computer name, current user, and current domain. It also 
displays the actions of menu items and toolbar buttons as you move the cursor over 
them. 

e Process window — This window shows your currently active process, which could be 
extraction, injection, incremental backup, or file restoration. 

f Action button — Click this button to begin the process that is active in the process 
window. 
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CM Settings Migration Manager Menus and Toolbar 
The CM Settings Migration Manager interface contains typical Windows-
based menu structures such as File, Edit, View, and Help. 

File Menu 

The File menu hasthe following commands: 

Table 1 File menu options 

Option 

Open 

Save 

Save As 

Select Data Store Location 

Exit 

Description 

Select configuration files 

Save current configuration file 

Save configuration files with a specified 
name 

Specify a network location or local drive and 
directory in which to store personality data 

Exit CM Settings Migration Manager 

Edit Menu 

The Edit menu has the following commands: 

Table 2 Edit menu options 

Option Description 

Preferences Opens the Preferences dialog box. The Preferences 
dialog box displays the Policies and Log File tabs. 

File Rules 

File Tree 

Registry Rules 

Delete Personalities 

Takes you directly to File Rules 

Takes you directly to File Tree 

Takes you directly to Registry Rules 

Allows you to delete selected personalities 
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View Menu 

The View menu has the following commands: 

Table 3 View menu options 

Option 

Toolbar 

Content Help Text Pane 

Status Bar 

Extract Personality 

Inject Personality 

Backup Personality Changes 

Restore Files From Personality 

View Last Log 

View Personality Logs 

Description 

Toggles to show or hide the toolbar 

Toggles to show or hide the Content 
Help Text Pane 

Toggles to show or hide the Status Bar 

Changes to the Extract Personality view 

Changes to the Inject Personality view 

Changes to the Backup Personality 
Changes view 

Changes to the Restore Files view 

Displays the Log file from the last CM 
Settings Migration Manager process 

Opens a "browse" dialog to the 
personality data store directory giving 
the migration administrator or user the 
ability to select and view log files 
associated with each personality. 

Help Menu 

The Help menu has the following commands: 

Table 4 Help menu options 

Option 

Help on CM Settings Migration 
Manager 

About CM Settings Migration 
Manager 

Description 

Opens CM Settings Migration 
Manager Help 

Displays the copyright notice and 
version number of your copy of 
CM Settings Migration Manager 
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CM Settings Migration Manager Toolbar 

Figure 7 Toolbar 

Legend 

a Save Configuration File 


b Edit Preferences 


c File Rules 


d File Tree


e Registry Rules 


f Last Log File 


g Personality Log Files 


Users to Extract View 
The Extract Personality view always appears when you start CM Settings 
Migration Manager: 
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Figure 8 Extract Personality view 

Legend 

a	 Users Selected for Extraction — Displays Information to identify specific users 
selected for extraction. 

b	 Extract From — Select to extract the personality for only the Logged In User, or for a 
single or multiple users selected in the User to Extract list. 

Data Store — Indicates where personality will be stored on a local drive or on the 
network. 

d	 Users to Extract — Displays a list of users on the computer that are available to select 
for extraction. 

e	 Action Button — Click this button to begin the extracting the users you have selected. 
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Select For Extraction View 
When you click the Select for Extraction tab, you see the following: 

Figure 9 Select for Extraction view 

Legend 

a	 Select for Extraction — The list of personality objects that can be extracted to the 
Data Store. Select what you would like to extract by checking the boxes. 

b	 Content Help Text Pane — For each content item that your mouse pointer hovers 
over, pertinent information is displayed in this window. 
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Extraction Information 


To select the Data Store location click Browse, or go to File → Select Data 
Store Location. Click the button to display a standard navigational window 
from which a drive and directory can be selected. 

Users to Extract 

This screen displays a list of users that exist on the computer where the CM 
Settings Migration Manager is currently running. If you are logged on to the 
computer as a user that is in the local administrator group, you will be able 
to select a single user or multiple users from the list for personality 
extraction. If you are logged on to the computer as a user that is not in the 
local administrator group, only the currently logged on user will be available 
for personality extraction. 

Select for Extraction 

CM Settings Migration Manager will migrate a personality based on its built-
in knowledge of the settings and files that are associated with many common 
applications. The settings and files to be moved are specified by selecting the 
personality objects in the Select for Extraction window, which are grouped by 
application. 

Select items to extract by checking that item’s check box. Exclude items by 
clearing the checkbox. 

•	 The Clear All button at the bottom of the window turns off all check 
marks. 

•	 The Select All button sets all check marks. 

•	 The Expand All and Collapse All buttons allow you to change how the 
objects are viewed in the window. 

The extraction objects that are selected are saved with the Configuration 
File. Saving your configuration will help speed up the processing of multiple 
computers. To save the CM Settings Migration Manager configuration file 
use the File menu or click Save Configuration File. 
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Extract 

Click Extract to start the extraction process. A progress and status dialog 
appears. The extraction process can be cancelled (unlike the injection 
process). 

When finished, the program displays a dialog box informing you that the 
extraction was successful, displays a log file, and returns to the Extraction 
View. 

Users to Inject View 
To get started with a typical injection process, start CM Settings Migration 
Manager. Click the Inject Personality icon to display the Inject Personality 
View. See Figure 10 on page 48 for a full explanation of this view. 
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Figure 10 Inject Personality view 

Legend 

a Data Store — Indicates the default location where the extracted personalities have been 
stored. 

b	 Personality Selection Field — Displays a drop down list of previously extracted 
personalities in the selected data store. 

User(s) to Inject — Displays a list of users that are available to select for injection. 

d	 Action Button — Click this button to begin the injection of the users you have selected 
and all data previously extracted for that user. 
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Select for Injection View 
When you click the Select for Injection tab, the list of files that you extracted 
in the past for the selected personality appear. Check the box next to the 
items you want to move to the target PC. 

Figure 11 Select for injection view 

Legend 

a Data Store —The default location where the extracted personalities have been stored. 

b Personality Selection Field — Displays the personality you have previously extracted 
and have selected to inject. 

Data to Inject — Displays a list of data that are available to select for injection to the 
target PC. 

d Action Button — Click this button to begin the injection of the user and data you have 
selected. 
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Injection Information 
To select the Data Store location use the adjacent Browse button, or go to 
File → Select Data Store Location. Click these buttons to display a standard 
navigational window from which a drive and directory can be selected. To 
open a configuration file, go to File → Open and select a configuration file. 
The configuration file that is currently open is shown in the CM Settings 
Migration Manager title bar. 

Personalities 

Select a personality from the Personalities drop down by clicking on it. 
Personalities can be deleted by going to Edit → Delete Personalities. 

Users to Inject 

This tab displays the users available to be injected from the selected 
personality. De-select the users you do not want to inject by clearing the 
check box next to the username. 

•	 The Clear All button at the bottom of the window turns off all check 
marks. 

•	 The Select All button sets all check marks. 

•	 The Expand All and Collapse All buttons allow you to change how the 
users are viewed in the window. 

User Destination 

Enables you to change where the selected user will be injected. To change the 
destination of a user, select a user from the User(s) to Inject window. When 
you select a user, you will notice that the user information in the Select User 
Destination window changes to the user that you selected. From this window 
you can select a user that exists on the machine to inject to or select a user 
from the list of network users. The default is to inject to the username of the 
user that was extracted. 
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Select for Injection 

The Select for Injection window lists extracted items included in the selected 
personality. De-select items you do not want to inject by clearing the item’s 
check box. 

•	 The Clear All button at the bottom of the window turns off all check 
marks. 

•	 The Select All button sets all check marks.  

•	 The Expand All and Collapse All buttons allow you to change how the 
objects are viewed in the window. 

Inject 

Click Inject to start the injection process. A progress and status dialog 
appears. After the injection process starts, it can be cancelled, but you must 
wait for CM Settings Migration Manager to finish its current process and 
activate the CM Settings Migration Manager window again. 

Edit → Preferences Menu 
Various CM Settings Migration Manager options and preferences can be set 
through the Edit → Preferences dialog box. This dialog can also be activated 
by the Edit Preferences toolbar button. The two tabs that are available in the 
Preferences dialog are those for controlling Policies and Log File options. 

Policies 
This tab Includes Extraction Policies, Injection Policies, and File 
Replacement Rules. 
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Figure 12 Policies 

Extraction Policies 

These policy selections only affect the personality extraction process. 
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Exclude User's Temporary Directory or Exclude User's Temporary 
Internet Directory 

CM Settings Migration Manager normally scans all directories looking for 
files that need to be migrated. Since temporary directories normally contain 
only temporary files, and can grow to be very large, the option to exclude 
these directories from CM Settings Migration Manager scans is available. 

Please note that this policy is checked to exclude these directories by default. 
To include these directories go to the Edit → Preferences → Policies tab. 
Deselect the Exclude User's Temporary Directory and Exclude User's 
Temporary Internet Directory check boxes to include these associated 
directories when scanned by CM Settings Migration Manager. 

Require Password Protection 

If this policy is selected you will be required to assign a password to each 
personality that you wish to extract. The password must be between 7 and 15 
characters in length, and can only contain letters, numbers and underscores.  
Passwords are case sensitive. 

Personalities that are password protected are displayed in the personality 
drop down menu with a lock icon. 

Figure 13 Lock icon 

To inject a password protected personality, click Inject and enter the assigned 
password. After the correct password has been entered, click OK and the 
personality will be injected. 

Disable Compression 

By default CM Settings Migration Manager will compress the extracted 
personality data. The compression ratio is approximately two to one. 
Selecting this policy will disable personality compression.  

Injection Policies 

These policy selections only effect the personality injection process. 
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Migrate Broken Shortcuts 

Shortcuts that have broken links are not migrated by default. For example, if 
there is a shortcut to an installed application on the source machine but that 
application is not installed on the target machine, the shortcut will not be 
migrated because it would have become a broken link on the target machine. 

To migrate broken link files select Edit → Preferences and select the Broken 
Shortcut Policy check box. The broken link files will be migrated to the 
source directory and placed in a folder named Broken Shortcuts. 

Created Accounts Get Local Administrator Rights 

If CM Settings Migration Manager will be creating user accounts on 
injection, you have the option to select to have those accounts created with 
local administrative rights. 

CM Settings Migration Manager only creates accounts on injection if 
the specified user does not already exist on that system. By default 
this policy is not selected. If this policy is not selected, the user is 
created with default user rights. 

Migrate Administrative Rights 

Selecting this policy will migrate the administrative rights for a selected 
user. For example, if the user was in the Administrator group on the source 
computer, the user will be populated in the Administrator group on the target 
computer following an injection. 

Prevent Injection to the Following Disks 

This policy enables you to specify letters associated with drives that you do 
not want CM Settings Migration Manager to inject data to during the 
personality migration.  

You cannot prevent injection to drive C. 

E x a m p l e :  

The source machine has two fixed drives (C:\ and D:\) both containing data. 
Data is extracted from both of the drives. On the target machine you also 
have drives C:\ and D:\. CM Settings Migration Manager by default will 
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inject the data that was extracted from the source computers C:\ and D:\ 
drives to the target computer's C:\ and D:\ drives. 

If you want data to inject only to the C:\ drive even if extracted from D:\, 
you can select this policy and exclude the D:\ drive from the injection. If the 
D:\ drive is excluded from the injection in this example, then the data that 
was extracted from the D:\ drive will be automatically injected to the root of 
the C:\ drive into a folder name Migrated_D_Drive. The file (and its 
corresponding directory structure) is copied to this directory. 

To exclude a single drive, simply enter the drive letter associated with the 
drive you want to exclude: 

Figure 14 Exclude a single drive 

To exclude multiple drives, enter the driver letters and separate each letter 
with a semi-colon ( ; ). 

Figure 15 Exclude multiple drives 

Allow Injection to Network Locations 

Selecting this policy will enable you to enter File Rules with destination 
paths targeting a network location. 

If you are injecting multiple users' files to the same network location, 
there is a risk that files with the same name will be overwritten and 
user data will be lost. 

For example the following file rule if used for multiple users could result in 
user files being overwritten: 

Figure 16 Sample file rule 

This rule extracts file types of .doc from the C:\ drive of the local machine 
and the subdirectories of the C:\ drive. On injection the Destination path 
targets the network-shared folder Data Files on Machine A. If this file rule 
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was used in a global configuration it could result in multiple user data file 
collisions, as each user’s .doc files would be redirected to the same folder on 
the network. 

Redirect PST Files 

Selecting this policy allows you to redirect Outlook .pst files to a specific 
location on the local machine or network. Note that the Allow Injection To 
Network Locations policy does not have to be selected in order to redirect .pst 
files to a network location. 

To redirect the PST files, select the corresponding policy and enter the 
desired redirection path in the available field. The redirection path can 
consist of a UNC path, the %HomeDrive% token, drive letter of a Home 
Drive, drive letter of a network drive, or a drive letter of a local drive. 

Example: 

Figure 17 Redirect the PST File 

When using the Redirect Active PST Files policy, in order for .pst
files to be redirected Outlook content must be selected. Outlook 
content can be selected for extraction by going to the Extract 
Personality view in CM Settings Migration Manager and then clicking 
the Select For Extraction tab. 

File Replacement Rules 

Select a file replacement option to govern how files specified with the File 
Rules or File Tree are handled when same-name files are found on the target 
computer. 

Always Replace 

Replaces files on the target computer that have the same name as files that 
were extracted using File Rules or the File Tree. 
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Replace If Newer 

Replaces files on the target computer that have the same name only if the 
files that were extracted have a modified date that is newer than the files on 
the target computer. 

Never Replace 

Never replaces files on the target computer that have the same name as files 
that were extracted using File Rules or the File Tree. 

“Restore Files” Ignores File Replacement Rules 

Selecting this policy will enable files to be restored using “Restore Files” to 
ignore the File Replacement Rules selection. 

Log File 
The CM Settings Migration Manager Log file can be customized by accessing 
Preferences through the Edit menu and selecting the Log File tab. 

Choose the level of log file detail from the radio buttons for Detailed Log, Log 
Content Titles Only or Log Content Titles and File Names Moved. 

CM Settings Migration Manager logs can be opened and viewed in an 
external viewer such as Microsoft Notepad. Your choices of log viewing 
options include: Display log on Completion, User Internal Viewer, or Use My 
Viewer. To use an external viewer, simply browse to the location of the 
viewing application such as notepad.exe. 

OV Setting Migration Manager Interface 57 



Figure 18 Customize the log file 

The name of the log file contains the computer name and the date and time of 
the extraction, injection, backup, or restore. Log files are located in the 
personality folder that is created when a personality is extracted with a 
naming convention of ComputerName_Ext. 

A log file is automatically displayed whenever a process finishes so the 
details of the process can be reviewed immediately. Automatically displaying 
the log file at the completion of a migration process is a default setting that 
can be changed by going to Edit → Preferences → Log File (tab). 

Log File Information 

Log files report every aspect of a migration, personality backup, and file 
restore. The log file can be used to identify all the files that were extracted, 
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injected, backed up, or restored in a given migration including file size, file 
count and file path. The log file also contains migrated application setting 
information where applicable as well as a list of users that were extracted or 
injected. 

Log File Sections 

The log file has several sections containing pertinent information about the 
personality extraction, injection, backup and restore. 

User Information 

This sections contains the name of the computer from which the extraction, 
injection, backup or restore was performed, the user name of the migration 
operator, and a list of extracted, injected, and backed up users including 
domain association. 

Time 

Displays the Start Time, End Time, and Elapsed time for the extraction, 
injection, or backup. 

Operating System 

Lists the version and service pack of the operating system from which the 
personality extraction, injection, backup or restore was performed. 

Local Fixed Drives 

Displays the used and free space of each fixed drive found on the system. 

Configuration Information 

Displays the name and location of the configuration file used for the 

migration. 


Data Store Information 

Displays the Data Store location and Personality Location/Name. 

Log Level 

Shows the level of Log Detail. The log level detail can be changed by going to 
Edit → Preferences → Log File. 
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Content Selected For Extraction/Injection 

List of application content (Data files and Settings) selected for migration or 
personality backup. 

Data Transport Policies 

Displays the extraction or injection policies that were selected for the specific 
migration. 

File Rules 

Lists the File Rules that were included for the migration or personality 
backup. 

File Section 

This section will display files that could not be extracted, injected or backed 
up as a result of the file or directory being inaccessible. When using Restore 
Files, this section of the log will list all files that were restored or not 
restored. It will also include a redirection path of the restored file if file 
redirection was used. 

Total Files 

Lists a total file count for the extraction, injection, or backup. 

Summary 

Displays the path and file count from which files were extracted, injected, or 
backed up. 

Detail 

Displays the file path, file name, file size and file count for each data file that 
was extracted, injected, or backed up. 
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6 Using File and Registry Rules 

This chapter introduces File Rules and the various rules that can be created 
using wildcards, tokens and file redirection. The chapter also describes the 
use of File Tree within a migration. Finally, there is a section on Registry 
Rules and how rules can be used to quickly migrate specific registry 
information. 
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File Rules 

Most desired data files can be migrated using CM Settings Migration 
Manager’s built-in support. Enterprise migration projects often require 
additional file migration support. For example, you may want to migrate 
proprietary file types created by internally developed applications. 

Designed for major migration projects, File Rules provides a method to 
include or exclude files by path, type, date, and size. Subdirectories can be 
included or not. Multiple rules can be created to tailor a migration to meet 
project goals and requirements. 

File Rules take precedence over files selected using the File Tree 
(discussed later). File Rules can also be used to override or modify file 
based personality objects selected in the Select for Extraction window. 

Accessing File Rules 

Go to Edit → File Rules to access File Rules: 

File Rules have hierarchical precedence. If two rules are mutually exclusive, 
the rule that appears higher in the list takes precedence over the rule that 
appears below. For example, precedence can be used to migrate all the .jpg 
files from the directory c:\files, yet prevent any other files in that directory 
from moving. 

Consider the following example. In this case, use precedence between 
mutually exclusive rules as follows: 

RULE 1: Include all .jpg files in c:\files 

RULE 2: Exclude all files from c:\files 

62 Chapter 6 



Figure 19 Data Transport – File rules 

Since Rule 1 takes precedence over Rule 2, any .jpg file found in the 
directory migrates. However, files of any other type found in the directory do 
not, since Rule 2 applies, and Rule 1 does not. 

Now consider the reverse order: 


RULE 1: Exclude all files from c:\files 


RULE 2: Include all .jpg files in c:\files 


Figure 20 Data Transport – File rules 
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In this case, no files found in the directory will migrate, since Rule 1 (exclude 
all files) takes precedence. 

Files can also be redirected to a different directory on the target computer 
with the Destination Re-mapping feature. Any path can be specified as a 
destination including network paths. Subdirectory structure can be preserved 
or not. 

Click Add Rule, Edit Rule, and Delete Rule to enter and manipulate rules. 

Figure 21 Data Transport – File rules 

To delete or edit a rule, select the rule in the Source Path column to highlight 
it, then click Delete Rule or Edit Rule. Rules can be moved in the list to 
adjust precedence by using the up and down arrow buttons on the right side 
of the dialog box. 

When finished, click OK or click Cancel to abandon the session. Rules in the 
list are saved when you save the current configuration  

Export and Import File Rules 

CM Settings Migration Manager can export and import File Rules to/from a 
text file. 
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Figure 22 Export and import file rules 

To export the list of entered File Rules, simply click on the export button. 
When you click on the export button the following save window is displayed. 
Save the file as type .txt or text. 

Figure 23 Save rules to text file 

To import File Rules to CM Settings Migration Manager click on the import 
button. After clicking on import, the following window will appear: 
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Figure 24 Import file rules 

Browse to the location of the text file that you want to import. Choose 
whether you would like to Append to the existing File Rules in CM Settings 
Migration Manager, or have the File Rules that exist in the text file replace 
those File Rules that already exist in CM Settings Migration Manager. 

Below is an example of the file rule format that should be used when 
importing File Rules from a text file into CM Settings Migration Manager: 

Start Rule 

Rule Type: Include 

Source Path: C:\files 

File(s):  *.doc 

Date Limit: No 

Size Limit: No 

Preserve Subdirectories: No 

Include Subdirectories: Yes 

Remap Destination: No 

End Rule 

File Rules Dialog Box 

When adding or editing a rule, the File Rule dialog box appears: 
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Figure 25 File Rule dialog box 

Include/Exclude 

Use the Include/Exclude radio button set to select the rule type. 

Source Path 

Enter the path of the files to be affected in the Source Path control. This 
control supports wildcard characters asterisk (*) and question mark (?) in the 
file name and file type portions of the path. The Source Path also supports 
Token Substitution. 

Specify Multiple File Types in the Source Path 

Separating files or file types with a semi colon (;) in the File Rule source path 
allows you to Include or Exclude multiple files or file types. 

Here are some examples of multiple file type rules: 
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Table 5 Multiple file type rules 

Include/Exclude File or Folder 
Specification 

Include 
Subdirectories 

Result 

INCLUDE C:\*.doc;*.xls;*.
mdb 

Yes Will find and extract files 
on the C: drive that match 
the specified file types. 

EXCLUDE C:\*.mp3;*.dll;*.
exe 

Yes Will exclude files on the C: 
drive from being extracted 
that match the specified 
file types. 

Specify Multiple File Types Using "Import File Rules" 

Example of the file rule format that should be used when importing File 
Rules into CM Settings Migration Manager with multiple files or file types 
specified: 

Start Rule 


Rule Type: Include


Source Path: C:\files


File(s):  *.doc;*.xls;*.mdb;*.ppt;*.rtf 

Date Limit: No 


Size Limit: No 


Preserve Subdirectories: No 


Include Subdirectories: Yes 


Remap Destination: No 


End Rule


After imported, the file rule will be displayed as follows in the File Rule 
dialog window. 
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Figure 26 File Rule dialog box 

The Use of Wildcard Syntax In The Source Path 

The common wildcards, question mark (?) (match one) and asterisk (*) ( 
match any) , can be used in file name syntax to specify files or groups of files. 
They can only be used in the file name and file type portions of the path. 
Here are some examples of valid wildcard usage: 

Table 6 Wildcards in the Source Path syntax 

Include/ 
Exclude 

File or Folder 
Specification 

Include 
Subdirectories 

Will Find Files Named 

INCLUDE C: \Readme.* Yes Readme.doc, 
Readme.wri,Readme.txt, 
etc., on the C: drive 

INCLUDE C: \Read*.doc Yes Readme.doc, Readthis.doc, 
etc., on the C: drive 

INCLUDE C: 
\Readme.??? 

Yes Readme.doc, Readme.wri, 
Readme.txt, etc. on the C: 
drive. 

Will not include the files: 
Readme.html, Readme.jpeg, 
etc. 
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Include/ 
Exclude 

File or Folder 
Specification 

Include 
Subdirectories 

Will Find Files Named 

INCLUDE C: 
\Read??.txt 

Yes Readme.txt on the C: drive. 

Will not find Readthis.txt 

Using Token Substitution in File Rules 

Complementing wildcards in File Rules is token substitution. Tokens can be 
substituted for explicit folder locations in constructing File Rules. This is 
useful since these folder locations can vary by operating system; tokens 
permit the rules to be cross operating system in nature. 

Supported tokens are: 

Table 7 Supported tokens 

Token 

%DESKTOP% 


%USERNAME%


%MYDOCUMENTS% 


%MYMUSIC% 


%MYPICTURES% 


%MYVIDEOS% 


%WINDOWS% 


%SYSTEM%


%FIXEDDISKS% 


%HOMEDRIVE%


%USERPROFILE% 


Description 

The Desktop “directory” 

The user name of the user that is selected for 
extraction. 

The default document storage folder 

The default music storage folder 

The default pictures storage folder 

The default videos storage folder 

The Windows directory (\Windows, \WINNT) 

The Windows\System folder (\Windows\system, 
\WINNT\system32, \Windows\System32) 

All local fixed drives (Can only be used in the 
source path of a file rule) 

Redirect files to a user's local or network home 
drive (Used only in the Destination Path of a file 
rule). 

The user's profile folder (Example:  C:\Documents 
and Settings\Username). 
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Here are some examples of token substitution usage: 

Table 8 Token substitution usage 

Include/Exclude File or Folder Specification Result 

INCLUDE %DESKTOP%\*.* Includes files and folders on the 
desktop regardless of Windows 
version 

EXCLUDE % FIXEDDISKS% \*.mp3 Excludes all mp3 files on all fixed 
disks 

INCLUDE %USERPROFILE%\test.doc Includes the test.doc file for the 
user that was selected for 
extraction. 

INCLUDE %MYDOCUMENTS%\*.jpg Includes all “. jpg ” files in the 
selected user's My Documents 
folder. 

Include Subdirectories 

By default the Include Subdirectories check box is checked to include the 
subdirectories of the Source Path. If this is not desired behavior simply 
uncheck Include Subdirectories for each file rule. 

Exceptions by File Date and Size 

File Rules can be limited by Date and File Size by using the controls in the 
Date and File Size group boxes. This can reduce the load on intermediate 
storage and network bandwidth and enforce corporate standards. 

In the examples in the following table, you can see how CM Settings 
Migration Manager can search for files and qualify their inclusion by limiting 
the migration to recent or reasonably sized files. The EXCLUDE example 
shows how files not supported by a migration can be specifically disallowed. 

Table 9 Exceptions by file size or date 

Include / 
Exclude 

File or Folder 
Specification 

Include 
Subdirectories 

Since or 
Before Date 

File Size 
Limits 

INCLUDE C:\*.jpg Yes On or After 
1/1/01 
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Include / 
Exclude 

File or Folder 
Specification 

Include 
Subdirectories 

Since or 
Before Date 

File Size 
Limits 

INCLUDE C:\*.avi Yes On or After 
1/1/01 

<= 10MB 

EXCLUDE C:\*.mp3 Yes 

Remapping Files and Folders 

File remapping gives CM Settings Migration Manager ultimate flexibility in 
migrating client data. To complement all the capabilities previously 
discussed, the migration administrator can clean up and organize client data 
as desired. In combination with wildcards and token substitution, almost any 
custom file moves can be accomplished — even between operating systems. 
Some examples will illustrate the point: 

Table 10 Remapping files and folders 
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INCLUDE C:\*.wav Yes %MYDOCUMENTS% 

\FoundSoundfiles 

No All .wav files on the C: 
drive will be put into 
the FoundSoundfiles 
folder in the My
Documents folder. 
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INCLUDE D:\*.gif Yes C:\FoundGifs Yes All .gif files on the 
D: drive will be put 
into C:\FoundGifs, 
preserving 
subdirectory structure 
from the source 
computer. For 
example, the file 
D:\Personal\Mypic.g
if will be migrated to 
C:\FoundGifs\Person 
al\Mypic.gif 

Files Are Only Copied Once 

Although you can create two or more rules that may specify the same file or 
files for migration, only the rule with the higher precedence (closer to the top 
of the list) will migrate those files. 

The Word documents that exist in My Documents will not be copied twice. 
Only Word documents found outside of the My Documents folder will be put 
in the FoundDOCfiles subfolder. 

File Tree 
The File Tree was designed for selection of files to be migrated in a single 
session. The familiar, intuitive Windows tree structure is used to navigate to 
directories and select user files to migrate to the new computer. File Tree 
selections are persistent for the computer on which they were created. Click 
File Tree to open the Select Files for Migration dialog box: 
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Figure 27 Select Files for Migration 

Each drive, directory, and file can be selected by clicking on the check box 
next to its name. All files are available except those already affected by File 
Rules; File Rules take precedence over the File Tree. If all files in a drive or 
directory are selected, a blue check mark is shown. If some files in a drive or 
directory are selected, the check mark will be gray. If no files are selected, the 
check box will be empty. 

Check boxes with gray backgrounds indicate that the file is controlled by a 
File Rule. If the box is empty, the File Rule is excluding the file; if the box is 
checked, the File Rule is including the file. These files are not available for 
checking in this window. 

File Rules take precedence over this File Tree function. 
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File Type Selection with File Tree 

File types can also be specified for inclusion or exclusion by right-clicking any 
folder. Select whether to include or exclude from the pop-up menu: 

A multiple-selection list box of the file types found in the selected folder and 
all subfolders appears as you see here: 

Figure 28 File Types 

Select one or more file types for inclusion or exclusion by highlighting the 
item them immediately clicking OK. To choose multiple file types, hold down 
the shift key while highlighting the file types then click OK. 

Registry Rules 
Registry Rules enables a migration administrator to identify registry keys 
and values or an entire registry branch to be included in a personality 
migration. Registry Rules are specified in the Edit → Registry Rules dialog 
and are saved when the configuration file is saved. 

Migrating registry keys and values is a powerful functionality that will 
enable a migration administrator to customize the migration of specific 
settings that are housed in the registry and not directly supported by CM 
Settings Migration Manager content. 
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Migrating some registry values and keys can result in an unstable 
environment on the target system. The use of Registry Rules is 
intended for a migration administrator with working knowledge of 
CM Settings Migration Manager and the Windows Registry. 

Registry Rule Definitions 

Registry (Window Pane) 

The left pane of the Registry Rules interface displays the registry of the 
machine. 

Type (Branch, Key, Value) 

• Branch: Migrates the values in the specified key and all sub keys 

• Key: Migrates the values in the specified key only 

• Value: Migrates the specified value 

Figure 29 Registry rule definitions 
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The Registry Rules supports both manual entry of registry keys and values 
as well as drag and drop functionality. To add a registry key or value as a 
registry rule for migration, locate the key or value you want to migrate in the 
registry window, select it and drag it to the  to the registry rule list.  

To manually enter a registry key or value, first select the type (Branch, Key, 
or Value), enter the registry path in the Key field, and then specify the value 
(if applicable). To add the rule to the list, click Enter on your keyboard or 
simply left click with your mouse cursor inside the registry rule list. 

After the rules have been entered either manually or using the drag and drop 
functionality the type, path, and value can be edited by simply clicking on the 
section of the rule you wish to edit. To delete a registry rule, select the rule 
and click Delete Rule. To save the added registry rules, click OK and then 
save the configuration. 
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7	 Back up Personality Changes and 
Restore Files 

CM Settings Migration Manager supports functionality to perform 
incremental personality backups and selective data file restore. These 
features allow a user or migration administrator the ability to refresh and 
maintain a previously extracted personality and then selectively restore the 
files or perform a full personality injection. 
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Backup Changes 

When executing the Backup Changes process to an existing personality, the 
source computer (the computer where the personality was originally 
extracted) is scanned for file changes that correspond to the selected or 
identified personality. Any associated files that have been added or changed 
on the source computer are updated in the personality. This allows the user 
or migration administrator to maintain a single personality backup without 
having to generate a new personality by performing another extraction. 

The incremental processing is done for data files only, and not for 
application or window's settings. When changes to files are backed up 
to the personality the settings (regardless if they have changed from 
when they were originally extracted) will be extracted to the 
personality again along with any changes to the data files.  The 
extraction of application settings and window's settings has a minimal 
effect on the performance during an incremental data backup 

Backup Changes and Password Protected Personalities 

Password protected personalities will not prompt the user to enter a 
password when the personality is selected in Backup changes view or 
prior/during the backup process (automated or from the user interface). This 
is because personalities can only be backed up on the same computer from 
which the initial extraction was performed. 

Backup Changes Process (User Interface) 

Backing up file changes associated with a personality first requires a 
personality to be extracted. 

(For information about Personality extraction please see Chapter 3 of this 
document.) 

To backup changes to a personality invoke the CM Settings Migration 
Manager on the computer to which the personality was originally extracted. 
Select the Backup Changes icon in the active process bar. This will change 
the view to Backup Personality Changes. 

1	 Select the personality you wish to backup from the Personality drop-down 
field. 
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Figure 30 Personality selection field 

Legend 

a	 Personality Selection Field — Click on the drop-down button to display all the 
personalities associated that are stored in the listed data store path. 

Make sure the data store path is correctly pointing to the location 
where the personality was extracted. If the personality is not 
available for selection it is possible the data store path is not correct. 
Simply browse to the correct data store location. 

2	 After the personality is selected, the users that were extracted with that 
personality are displayed in the Extracted Users tab window. Selecting 
the Extracted Content tab displays a list of the content that was selected 
for extraction. The settings and any changes made to the data files on the 
computer associated with this content (and any File Rules that were 
saved with the configuration) will be backed up to the personality. 

The Extracted Users tab and Extracted Content tab are for 
information and viewing purposes only. 
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Figure 31 Extracted Users tab 

Legend 


a Extracted Users — Displays the users that were extracted for the selected personality.
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Figure 32 Extracted Content tab 

Legend 

a	 Extracted Content — Displays a list of content (Application Settings and Data Files) 
that was extracted for the selected personality. 

3	 Click Backup Changes, and CM Settings Migration Manager will 
automatically backup the personality settings and any data files that 
have changed since the original extraction or last backup process was 
executed. When the backup process is complete, a log file is displayed 
containing detail of the personality backup. 

Backup Changes Process (Automation) 
A personality can be automatically backed up via command line using the 
CM Settings Migration Manager supported command line switch 
/AUTOBACKUP. 
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The personality can only be backed up on the computer from which 
the personality extraction originated. 

If a personality is not specified via command line, by default the 
/AUTOBACKUP switch will scan the personality data store location for a 
personality object that has a folder name associated with the computer name 
from which the backup process is being executed. If no personality is found 
based on the parameters used, or multiple personalities are found to exist, 
the process will terminate with the appropriate exit code. 

By default when CM Settings Migration Manager extracts a 
personality, the personality folder is created with the name of the 
computer from which the extraction took place. 

Example “Personality Backup” Command Lines 

Start /w se.exe /AutoBackup \\DataStore\PersonalityName 

This command line will perform a backup of file changes associated with the 
personality specified in the data store path. 

Start /w se.exe /AutoBackup 

This command line will look for a personality with a name that matches the 
name of the computer from which the command line is executed and backup 
the appropriate file changes. 

For a list of supported command lines, their functionality, and more 
information on using command lines to automate a CM Settings 
Migration Manager migration, please read Chapter 8, Command Line 
Interface. 

Restore Files 
Restore Files enables the user or migration administrator to search, examine, 
and selectively restore the files contained in an extracted or backed up 
personality. 

By default, files are restored based on the parameters used to extract the files 
(File Rules, or Application Data File Content). This means that if file.xyz
was extracted from C:\Data, then by default selecting to restore that file will 
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result in the directory location being preserved and the file being restored to 
C:\Data. CM Settings Migration Manager file restore does support an option, 
however, to override the default file restore behavior and restore files to 
alternate locations as identified by the user or migration administrator. 

The ability to selectively restore files is only functional via the CM 
Settings Migration Manager user interface. 

Restore Files and Password Protected Personalities 

Password protected personalities will prompt the user to enter a password 
when the personality is selected in the Restore Files view. The password 
must be entered in order to view the contents of the personality. 

Restore Files Process 

1	 After a personality has been created, the data files associated with that 
personality can be selectively restored using the Restore Files view in the 
CM Settings Migration Manager user interface. Select the personality 
from which files will be restored from the Personality drop-down list. 

Figure 33 Restore Files 

Legend 

a	 Personality Selection Field — Click on the drop-down button to display all the 
personalities associated that are stored in the listed data store path 

After the personality is selected, the data files can be accessed via the 
Files tab. All files and folders that were extracted are displayed in this 
window. 

4	 Expand each drive and folder to display the files that were extracted in 
that folder. 

5	 Select the data files you wish to restore and then click Restore Files. This 
will restore the selected files. 
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Figure 34 Restore Files 

Legend 

a	 Displays the drives and folders associated with the extracted personality data. Select a 
folder to display the data file contents. 

b	 File Selection — Select the files that will be restored. Double click on the file to change 
the file restore location, or to select a different version of the file to restore. 

Redirect Files during File Restore 

There are two methods of redirecting files to alternate locations. You can 
either set a global redirection path, or redirect individual files. 

To set a global redirection on selected files click Restore to in the Restore 
Files UI and browse to where all selected files will be restored. 
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Figure 35 Select global Restore To 

Legend 

a	 Select the global Restore To option and browse to where the selected data files will be 
restored. 

To redirect specific files to a new location, double click on the file to display 
the properties dialog. Browse to the desired path for the file and click OK. 
The file will be restored to the path that was specified.  Please note that the 
path specified to redirect the selected file will take precedence over the global 
restore path. 

When Backup Changes is used, each version of the file is stored in the 
personality. Use the drop down field to select the version of the file 
you wish to restore. By default, the most current version of the file 
will be restored and displayed in File Properties. 
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Figure 36 File Properties 

Legend 

a	 File Selection and Properties — Select the version of the file you 
wish to restore using the drop down field. 

b	 Browse — Use the browse button to select a restore path for the file. By 
default, the file will be restored to the same path from which it was 
extracted. 

c	 File Restore Path — Displays the path where the file will be restored. 

File Search 

To perform a search for files contained in the selected personality, click the 
“Search” tab accessible from the Restore Files user Interface. 

The user, or migration administrator can search the selected personality for 
files based on file name or file type. Select a drive or folder you wish to search 
and enter the name of the file or file type in the search field. Click Start 
Search to start the search. The files that are found based on the entered 
parameters will be displayed in the screen to the right. If no parameters are 
entered in the search field, then all files that exist in the selected drive or 
folder will be displayed. 
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Figure 37 Restore Files 

To restore the files that are displayed as a result of the performed search, 
simply check the files and then click Restore Files. 

Browse HTTP Personalities 

To restore files or perform a search on a personality that was extracted via 
HTTP, the data store must be changed to the correct HTTP server location. 
To change the data store location to HTTP, click Browse next to the Data 
Store field while in Restore Files view. Next click the HTTP Server button to 
open the HTTP Options dialog. Enter the appropriate Server Name, Folder 
Name, and Port Number. 
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Figure 38 Click HTTP Server to open HTTP Options dialog box 

Legend 

a	 HTTP Server — Select HTTP Server to open the HTTP Options dialog 
window. 

Clicking the HTTP Server button displays the following dialog: (Example 
entries shown) 
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Figure 39 HTTP Options dialog box 

Server Name:  Enter the HTTP Server name or IP address in this field. 

Folder Name:  Enter the name of the folder where the personalities are 
stored. 

Port Number:  Enter the appropriate port number in this field. 
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8 Command Line Interface 
CM Settings Migration Manager supports operation from the command line 
for environments in which more automatic operation is desired. Using the 
command-line interface enables CM Settings Migration Manager to be 
incorporated into scripts to automatically perform an extraction, injection, or 
backup. Coupled with CM Settings Migration Manager’s powerful 
configuration features, technicians can manage large-scale migrations and 
personality backups with minimum interaction. 
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Overview 
The most common usage for command-line switches is to group them together 
in a batch file. By grouping together the command-lines for the Extraction a 
computer’s personality can be extracted by running only one file, without any 
user interaction. The command-line switches can also be launched from 
network login scripts when users log into the network. By calling these batch 
files from login scripts, administrators can remotely perform Extractions and 
Injections without having to physically visit the PC. 

Automating Personality Migrations 

Using command line switches, CM Settings Migration Manager can be set up 
to automatically extract, inject or backup the personality of the currently 
logged in user, a user that is not logged in to the computer, or multiple users. 
The personality is extracted on the source PC and automatically injected on 
the target PC. This section of the guide details all supported command line 
switches followed by batch file examples that will assist you in the 
development of an automated migration process. 

Many of the functionality descriptions of the command line switches 
will reference exit code returns. The full list of supported exit codes is 
available in Appendix B of this Deployment Guide. We recommend 
that exit codes be included in the batch files that you develop. 
Examples of how exit codes are incorporated in batch files are also 
available in Appendix B, Exit Codes. 

To extract, inject or backup a personality for a user or users that are 
not currently logged in to the machine, the user that is performing the 
extraction, injection or backup must have Local Administrator Rights.  
Also note that CM Settings Migration Manager requires elevated 
administrator privileges when running on Windows Vista. 
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CM Settings Migration Manager Application 
Command Line Switches 

/AUTOEXTRACT (Extraction Only) 

The /AUTOEXTRACT command, if used without another supported extraction 
command switch will automatically perform a personality extraction of the 
user that is currently logged on to the computer. It is important to note that 
the default CM Settings Migration Manager configuration will be used if a 
configuration file is not specified in the command line. Therefore, 
administrators will have to configure CM Settings Migration Manager with 
the desired settings. See Chapter 3, Extracting using CM Settings Migration 
Manager for details on the CM Settings Migration Manager configuration 
file. 

Example 1 — Command Line using /AUTOEXTRACT 

START /w se.exe /autoextract 

/AUTOINJECT (Injection Only) 

The /AUTOINJECT command, if used without another supported injection 
command switch will automatically perform a personality injection for the 
user that is currently logged on to the computer. CM Settings Migration 
Manager searches the default data store for personalities with a user name 
that matches the user name of the currently logged on user. If only one 
matching personality containing that username is found the personality for 
that user is injected. If more than one matching personality is found, or no 
matching personalities are found, CM Settings Migration Manager will 
terminate and return an appropriate exit code. 

Example 2 — Command Line using /AUTOINJECT 

START /w se.exe /autoinject 

/PASSWORD 

The /PASSWORD command is used to automatically assign a password to a 
personality during extraction and injection. The specified password must be 7 
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to 15 characters in length and is case sensitive. When the /PASSWORD
command is used for extraction and the password is either missing or invalid 
CM Settings Migration Manager will terminate and return an appropriate 
exit code. When the /PASSWORD command is used for extraction or injection, 
and the password is either missing or invalid, CM Settings Migration 
Manager will terminate and return an appropriate exit code. If the 
/PASSWORD command is used to inject a personality and the specified 
password does not match the password assigned to the personality, CM 
Settings Migration Manager will terminate and return an appropriate exit 
code. 

Injections will only occur if the password specified using the 
/PASSWORD command switch matches the password assigned to the 
personality.  

Example 3 — Extraction Command Line using /PASSWORD 

START /w se.exe /autoextract /PASSWORD password 

Example 4 — Injection Command Line using /PASSWORD 

START /w se.exe /autoinject /PASSWORD password 

/CONFIG 

The /CONFIG command-line argument is used to specify a configuration file 
when performing an automatic extraction or injection. The form of the 
argument is: /CONFIG path\file. If the specified path to the configuration 
file is invalid CM Settings Migration Manager will terminate and return an 
appropriate exit code. 

Path\file is the path and filename of the desired configuration file. The 
path can also specify a mapped drive. A complete command might look like 
the following example, where Z:\ is a mapped drive on a remote server. 

Example 5 — Extraction Command Line using /CONFIG 

START /w se.exe /autoextract /CONFIG "Z:\CM Settings Migration
Manager Installation\Test.CFG" 

Example 6 — Injection Command Line using /CONFIG 

START /w se.exe /autoinject /CONFIG "Z:\CM Settings Migration
Manager Installation\Test.CFG" 
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/IMPORT (Extraction Only) 

This command imports a predefined list of File Rules via the autoextract 
command line. The text file that contains the File Rules uses the same format 
as the rules that are created and exported using the CM Settings Migration 
Manager File Rules dialog. See Chapter 6, Using File and Registry Rules for 
detailed information on the correct file rule format to use when exporting 
importing File Rules into CM Settings Migration Manager. 

Example 7 — Extraction Command Line using /IMPORT 

START /w se.exe /autoextract /import Z:\rules.txt 

/SOURCE (Injection only) 

The /SOURCE command is used to specify the computer name that was 
associated with the extracted personality. This command is typically used in 
combination with the /ALLUSERS command line switch and only on Injection. 
When used in conjunction with the /ALLUSERS switch, all the users 
associated with the personality that matches the specified computer name 
following the /SOURCE command will automatically inject. If there are no 
matching personalities or if there is more than one matching personality then 
CM Settings Migration Manager will terminate and return an appropriate 
exit code. 

Example 8 — Injection Command Line using /SOURCE 

START /w se.exe /autoinject /SOURCE computername /AllUsers 

/INCLUDEUSER (Extraction) 

When used during extraction, the /INCLUDEUSER command will extract the 
personalities for each user that is specified following the command. If there 
are no usernames that match the users specified in the command line then 
CM Settings Migration Manager will terminate and return the appropriate 
exit code. If at least one user specified matches a username on the computer 
being extracted, but one or more other specified users do not match any 
usernames on the computer, the extraction process will continue and extract 
the personalities of the users that matched and the extraction log that gets 
created following an extraction will display the users that were not extracted. 
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Usernames and Domain names with spaces must be contained in 
quotes when specified following the /INCLUDEUSER command. This is 
referenced in Example 11 below. 

Example 9 — Extraction Command Line using /INCLUDEUSER (Multiple users 
specified) 

START /w se.exe /autoextract /INCLUDEUSER user1 user2 user3 

Example 10 — Extraction Command Line using /INCLUDEUSER (Users specified 
with domain) 

START /w se.exe /autoextract /INCLUDEUSER domain\user1
domain\user2 

Example 11 — Extraction Command Line using /INCLUDEUSER 

(Users and domains containing spaces) 

START /w se.exe /autoextract /INCLUDEUSER "domain 1\user 1"
"domain 1\user 2" 

/INCLUDEUSER (Injection) 

When used during injection, the /INCLUDEUSER command will inject the 
users from the personality for each matching username that follows the 
command. CM Settings Migration Manager will only inject the matching 
users if all specified users exist within a single personality. Using the 
/SOURCE command allows you to further narrow the possible personalities 
when comparing usernames. If all users specified with /INCLUDEUSER exists 
in more than one personality, CM Settings Migration Manager will terminate 
and return the appropriate exit code. 

Usernames and Domain names with spaces must be contained in 
quotes when specified following the /INCLUDEUSER command. This is 
referenced in Example 14 on page 99. 

Example 12 — Injection Command Line using /INCLUDEUSER (Multiple users 
specified with domain) 

START /w se.exe /autoinject /SOURCE computername /INCLUDEUSER
domain\user1 domain\user2 domain\user3 
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Example 13 — Injection Command Line using /INCLUDEUSER 

This example illustrates how you can inject a user's personality into another 
username. This can be useful if the usernames associated with the extracted 
personalities are being changed to different usernames as part of the 
migration process. 

START /w se.exe /autoinject /SOURCE computername /INCLUDEUSER
user1:user1a user2:user2a user3:user3a 

Example 14 — Injection Command Line using /INCLUDEUSER 

This example illustrates how you can inject a user's personality to another 
username or domain. This can be useful if the usernames associated with the 
extracted personalities are being changed to different usernames as part of 
the migration process or are being migrated to a machine that is registered to 
a different domain. Please note that in this example the entire user string 
must be contained in quotes as a result of the username containing a space. 

START /w se.exe /autoinject /SOURCE computername /INCLUDEUSER
"domain1\user 1:domain2\user 1a" "domain1\user 2:domain2\user 
2a" 

/ALLUSERS  (Extraction) 

The /ALLUSERS command will extract all existing users on the computer. 

Example 15 — Extraction Command Line using /ALLUSERS 

START /w se.exe /autoextract /ALLUSERS 

/ALLUSERS  (Injection) 

The /ALLUSERS command will inject all users in a specified personality. The 
personality can be specified using the /SOURCE command. 

Example 16 — Injection Command Line using /ALLUSERS 

START /w se.exe /autoinject /SOURCE computername /ALLUSERS 
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/EXCLUDEUSER (Extraction) 

The /EXCLUDEUSER command allows you to exclude specified users from being 
extracted. This command is most commonly used in conjunction with the 
/ALLUSERS command. If by using this switch it results in no users being 
extracted, CM Settings Migration Manager will terminate and return an 
appropriate exit code. 

Example 17 — Extraction Command Line using /EXCLUDEUSER 

In this example all the users on the computer will be extracted unless a user 
matches the username that follows the /EXCLUDEUSER command. Multiple 
usernames can also be specified using the /EXCLUDEUSER command. 

START /w se.exe /autoextract /ALLUSERS /EXCLUDEUSER
domain\user1 

/EXCLUDEUSER (Injection) 

The /EXCLUDEUSER command allows you to exclude specified users from being 
injected. This command is most commonly used in conjunction with the 
/ALLUSERS command. If by using this switch it results in no users being 
injected, CM Settings Migration Manager will terminate and return an 
appropriate exit code. 

Example 18 — Injection Command Line using /EXCLUDEUSER 

In this example all the users in the specified personality will be injected 
unless a user matches the username that follows the /EXCLUDEUSER
command. Multiple usernames can also be specified using the /EXCLUDEUSER
command. Specifying the domain name is optional. If the domain name is not 
specified then all users matching the username are excluded. 

START /w se.exe /autoinject /Source computername /ALLUSERS
/EXCLUDEUSER domain\user1 

/EXCLUDELOCAL  (Extraction) 

The /EXCLUDELOCAL command allows you to exclude local users from being 
extracted. This command is most commonly used in conjunction with the 
/ALLUSERS command. If by using this switch it results in no users being 
extracted, CM Settings Migration Manager will terminate and return an 
appropriate exit code. 
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Example 19 — Extraction Command Line using /EXCLUDEUSER 

In this example all the users on the computer will be extracted except for 
those users that are defined as a local user. 

START /w se.exe /autoextract /ALLUSERS /EXCLUDELOCAL 

/EXCLUDELOCAL  (Injection) 

The /EXCLUDELOCAL command allows you to exclude local users from being 
injected. This command is most commonly used in conjunction with the 
/ALLUSERS command. If by using this switch it results in no users being 
injected, CM Settings Migration Manager will terminate and return an 
appropriate exit code. 

Example 20 — Injection Command Line using /EXCLUDEUSER 

In this example all the users in the specified personality will be injected 
except for local users. 

START /w se.exe /autoinject /Source computername /ALLUSERS
/EXCLUDELOCAL 

/EXCLUDEUNUSED (Extraction Only) 

The /EXCLUDEUNUSED command allows you to exclude user profiles that have 
not been used in a specified number of days. This command is most 
commonly used in conjunction with the /ALLUSERS command. 

Example 21 — Extraction Command Line using /EXCLUDEUNUSED 

In this example all the users on the computer will be extracted except for 
those users whose profiles have not been used in 25 days. 

START /w se.exe /autoextract /ALLUSERS /EXCLUDEUNUSED 25 

/DOMAIN (Injection Only) 

The /DOMAIN command allows you to redirect injected users from an old 
domain name to a new domain name. Multiple domain redirections can be 
specified as illustrated in Example 23 on page 102. This command is typically 
used in conjunction with the /ALLUSERS command on injection. 
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Domain names with spaces must be contained in quotes when 
specified following the /DOMAIN command. This is referenced in 
Example 24 below. 

Example 22 — Injection Command Line using /DOMAIN 

In this example all the users contained in the specified personality who 
belong to olddomain will be injected to the new specified domain. 

START /w se.exe /autoinject /SOURCE computername /ALLUSERS
/DOMAIN olddomain:newdomain 

Example 23 — Injection Command Line using /DOMAIN 

In this example all the users contained in the specified personality who 
belongs to olddomain and olddomain2 will be injected to the new specified 
domain. 

START /w se.exe /autoinject /SOURCE computername /ALLUSERS
/DOMAIN olddomain:newdomain olddomain2:newdomain2 

Example 24 — Injection Command Line using /DOMAIN (specified domain name 
contains a space) 

In this example all the users contained in the specified personality who 
belong to old domain will be injected to the new specified domain. The 
domain names that are specified following the /DOMAIN command switch 
have spaces and therefore the entire string must be contained in quotes. 

START /w se.exe /autoinject /SOURCE computername /ALLUSERS
/DOMAIN "old domain:new domain" 

/DATASTORE 

This /DATASTORE command can be used to specify an alternate location for 
the CM Settings Migration Manager data store. The path to the data store is 
specified following the command line switch. This use of the /DATASTORE
switch will override the path in the configuration file. If the path specified 
following the /DATASTORE switch does not exist, it will be created. If it cannot 
be created, CM Settings Migration Manager will terminate and return an 
appropriate exit code. 
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By design CM Settings Migration Manager does not extract files at or 
below the folder level that you specify for the Data Store. Please take 
this into account when specifying a data store location. 

Example 25 — Command Line using /DATASTORE 

START /w se.exe /autoextract /DATASTORE \\server\personalities 

/EXCLUDEDISKS (Injection Only) 

This /EXCLUDEDISKS command enables you to specify letters associated with 
drives that you do not want CM Settings Migration Manager to inject data to 
during the personality injection. 

You cannot prevent injection to drive C. 

Example 26 — Command Line using /EXCLUDEDISKS 

START /w se.exe /autoinject /EXCLUDEDISKS D;E;F 

/INJECTTOLOGGEDINUSER (Injection Only) 

This /INJECTTOLOGGEDINUSER command enables you to force an injection of 
a user's personality to the user that is logged on to the target machine even if 
the username does not match the username of the user that is being injected. 

A personality with more than one user cannot be injected to the 
logged on user using the /INJECTTOLOGGEDINUSER command line 
switch. If there is more than one user in the personality being 
injected, the use of the /INJECTTOLOGGEDINUSER switch will result in 
an appropriate exit code. 

Example 27 — Command Line using /INJECTTOLOGGEDINUSER 

START /w se.exe /autoinject /IncludeUser User1
/InjectToLoggedInUser 
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/AUTOBACKUP (Personality Backup Only) 

The /AUTOBACKUP command allows you to backup changes to a specified 
personality via command line. 

Example 28 — Command Line using /AUTOBACKUP 

Start /w se.exe /AUTOBACKUP \\DataStore\PersonalityName 

This command line will perform a backup of file changes associated with the 
personality specified in the data store path. 

Start /w se.exe /AUTOBACKUP 

This command line will look for a personality with a name that matches the 
name of the computer from which the command line is executed and backup 
the appropriate file changes. 

/EXCLUDEDOMAIN 

The /EXCLUDEDOMAIN command is used exclude users from being injected or 
extracted if they are associated with the specified domain following the 
/EXCLUDEDOMAIN command line switch. 

Example 29 — Command Line using /AutoExtract 

Start /w se.exe /AutoExtract /AllUsers /ExcludeDomain DomainX 

This command line will perform an extraction of AllUsers, excluding those 
associated with DomainX. 

/NOCANCEL 

The /NOCANCEL command is used to hide the CM Settings Migration 
Manager cancel button that is displayed on the progress bar during 
extraction. 

Example 30 — Command Line using /NoCancel 

Start /w se.exe /AutoExtract /AllUsers /NoCancel 

This command line will hide the progress bar during extraction. 
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/HIDESTATUS 

The /HIDESTATUS command is used to hide the CM Settings Migration 
Manager progress bar for extraction and injection. 

Example 31 — Command Line using /HideStatus 

Start /w se.exe /AutoExtract /AllUsers /HideStatus 

This command line will hide the progress bar during extraction. 

HTTP Command Line Usage 
/http servername:port uniquestring [overwrite:] 

This command line launches an HTTP extraction that is used in combination 
with /AUTOEXTRACT, /AUTOBACKUP or launches an injection that is used in 
combination with /AUTOINJECT. To use HTTP you must also use 
/AUTOEXTRACT, /AUTOBACKUP, or /AUTOINJECT commands. 

Personalities and log files will be stored in the pre-assigned Upload folder on 
the HTTP Server. Optionally, you can use the command lines /HTTPDIR to 
specify an alternate folder where the Personalities and log files will be stored. 

Command Line Definitions 

Servername 
This represents the NetBIOS name or IP address of the system running the 
HTTP Server. 

Port 
This represents the port number used by the HTTP Server. 

UniqueString 
This represents the unique name of the personality being extracted or 
injected. 

The specified Unique String cannot contain any spaces or quotations. 

Overwrite 

This command line switch is optional and is used in conjunction with 
/AUTOEXTRACT. Use overwrite:yes to overwrite an existing personality 
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with the same UniqueString personality name. Use overwrite:no to prevent 
overwriting an existing personality name with an identical personality name. 
If overwrite: is not used the default behavior is not to overwrite an existing 
personality. 

/HTTPDIR 

Used to specify a directory where personalities are stored on the HTTP 
Server. The default directory is Upload. 

The HTTP server must be configured to use the specified directory. 

Example 32 — Command Line using /HTTP 

Extraction 

start /w se.exe /http ServerName:3466 UniqueString /AutoExtract
/AllUsers 

Injection 

start /w se.exe /http ServerName:3466 UniqueString /AutoInject
/AllUsers 

Example 33 — Command Line using /HTTPDir 

Extraction 

start /w se.exe /http ServerName:3466 UniqueString /AutoExtract
/AllUsers /HTTPDir DataStore 

Injection 

start /w se.exe /http ServerName:3466 UniqueString /AutoInject
/AllUsers /HTTPDir DataStore 
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A Response Files 

Using Response Files with CM Settings Migration 
Manager Automation 

Since there are limits to command line length in some environments and 
since the potential exists for complex command lines to exceed those limits, 
CM Settings Migration Manager supports command line response files. A 
response file contains command line arguments (switches) that are accessed 
indirectly. Command line response file support reflects the long-standing 
Microsoft response file behavior. An at sign (@) followed by a file specification 
will designate a response file to include in the logical command line. 

Response File Example 

The response file z:\response.txt contains: 

/IncludeUser user1 /Config z:\filename.cfg 

The logical command line processed by CM Settings Migration Manager is: 

Start /w se.exe /autoextract /IncludeUser user1 /Config
z:\filename.cfg 

Example 34 

This example will extract the personality of the user that is specified in the 
response file. 

start /w se.exe /autoextract @z:\response.txt 
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B Exit Codes 

Using Exit Codes with CM Settings Migration 

Manager Automation 


Exit codes are used during CM Settings Migration Manager automation to 
provide the technician performing the automation more information that can 
assist in resolving issues concerning the installation or operation of CM 
Settings Migration Manager. 

CM Settings Migration Manager Application Event Exit Codes 

Table 11 Application Event Exit Codes 

Exit 
code 

4 


5 


6 


7 


12 


14 


16 


246 


247 


248 


Description 

File write failure 

Out of memory 

Out of Disk Space 

Unknown error 

Process aborted 

Unable to process the users registry data 

Unable to create user 

Unable to create domain user 

Unable to determine logged in user 

Unable to open response file 

109 



Exit 
code 

249 


251 


252 


253 


254 


255 


257 


260 


261 


263 


264 


265 


266 


267 


268 


269 


270 


Description 

Injecting to a Windows 9x system is not supported by CM 
Settings Migration Manager 

No personalities exist for specified user on /autoinject command 
switch or not all of the requested users could be found in any 
personality 

No user exists for /autoextract command switch 

Invalid command line option 

Improper installation 

Insufficient rights to execute CM Settings Migration Manager 

More than one matching personality exists for specified 
/SOURCE on /AUTOINJECT command switch 

Insufficient rights to migrate users not currently logged on. 

Invalid response file 

Password is out of range must be between 7-15 letters, 
numbers, and/or underscores ("_") 

/AUTOEXTRACT and /AUTOINJECT cannot be used at the 
same time 

Invalid password 

Import file not found 

Import parameter not correct 

No content items were selected for extraction 

Error processing password 

Multiple personalities exist for specified user(s) on injection 
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Exit 
code 

271 


272 


273 


274 


275 


276 


277 


278 


279 


280 


284 


285 


286 


287 


288 


289 


290 


291 


Description 

Configuration file not found 

Invalid configuration file parameter 

Template file is obsolete 

Unable to open template file 

Invalid data store entry 

Configuration file is read-only 

Cannot create default configuration file 

Invalid configuration file 

Cannot save configuration file 

Cannot write to data store 

CM Settings Migration Manager is already running on this 
computer 

Client must be updated before continuing.  Invoke the CM 
Settings Migration Manager manually to update. 

No personalities exist for specified /SOURCE on /AUTOINJECT 
command switch 

Invalid /EXCLUDEUSER parameter 

Invalid /INCLUDEUSER parameter 

Extraction failed 

Injection failed 

Unable to open file TxxTxp.ptp 
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Exit 
code 

292 


293 


294 


295 


296 


297 


298 


299 


300 


301 


302 


303 


304 


305 


307 


310 


Description 

Multiple redirections to the same user 

Server disconnected 

An obsolete personality was specified 

Invalid /DOMAIN usage. Source domain and target domain 
must be separated by a ":"  Only valid with the /AUTOINJECT 
switch. 

Domain usage conflict. Cannot use /DOMAIN with 
/INCLUDEUSER switch if /INCLUDEUSER contains user 
redirection 

Invalid Exclude Disk Parameter 

Invalid Data Store 

The Receiver timed out waiting for Sender to connect 

The Sender timed out waiting to connect to a Receiver 

Receiver lost connection with Sender 

Invalid buffer size 

Connection string is in use.  Another process is already 
listening for the specified connection string 

Invalid connection string 

Multiple Network Interface Cards are not supported.  Please 
disable the Network Interface Cards that will not be used for 
migration. 

Personality already exists at data store location 

Invalid network options 
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Exit 
code 

311 


312 


313 


314 


315 


316 


317 


318 


319 


320 


321 


322 


323 


324 


325 


326 


327 


Description 

SE_INVALIDHTTPSWITCH - No port or no IPaddress or 
computer name 

SE_OUTOFMEMORY 


SE_OUTOFDISKSPACE 


SE_FILEWRITEFAILED


SE_INVALIDHTTPSWITCHNOSTRING - No unique string 
found with http switch 

SE_HTTPINVALIDONWIN95  


SE_INVALIDHTTPUSE - The HTTP switch cannot be used 
with /DATASTORE, or /SOURCE switches 

SE_UINOTALLOWED - The User Interface has been restricted 

SE_FILEACCESSDENIED - The operating system denied 
access to the specified file 

SE_HTTP_ERROR 


Invalid /EXCLUDEDOMAIN switch 

Spaces are not allowed in the upload directory 

CM Settings Migration Manager does not support backup on 
non-NT platforms 

HTTP server does not allow directory listing 

No personalities found. 

Load user registry hive failed 

/INJECTTOLOGGEDINUSER can only be used with a single 
user. 
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Exit Description 
code 

328 File too large to migrate 

Applying Exit Codes to Batch Files 
The CM Settings Migration Manager exit codes listed above can be applied to 
batch files using simple "IF ERRORLEVEL" commands. 

Example Batch File Incorporating CM Settings Migration

Manager Exit Codes 


The example below displays how exit codes are used within a CM Settings 
Migration Manager batch file.  The text that is displayed for each exit code 
can be changed if needed. 

When using the command "IF ERRORLEVEL" in a batch file, the exit 
codes must be listed with the greater number first in order for it to be 
called properly. 

CM Settings Migration Manager Application exit codes must be entered in 
order following the command line:  

"Start /w se.exe /autoextract /config Z:\filename.cfg 

Extraction Batch File With Exit Codes 

There are many supported exit codes that can be used in an CM Settings 
Migration Manager batch file. The following example is intended to illustrate 
how those exit codes are included in a batch file.  I In the following example 
only two applications event exit codes are used. We recommend that you 
incorporate all of the available exit codes into your batch files. 

This same format can also be used for an injection batch file 

114 Appendix B 



Example 

@echo off 

echo ...Extracting Personality 

START /w se.exe /autoextract /IncludeUser testuser /config
Z:\FileName.cfg 

IF ERRORLEVEL 253 Goto Err253 

IF ERRORLEVEL 247 Goto Err247 

cls 

goto EXIT 

:Err247 

cd c:\ 

C: 

Echo Unable to determine logged in user 

pause 

cls 

goto EXIT 

:Err253 

cd c:\ 

C: 

Echo Invalid command line option 

pause 

cls 

goto EXIT 

:EXIT 

cls 
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C Application Support Notes 

CM Settings Migration Manager provides a checklist of supported settings 
and files in the extraction and injection views. These items, known as 
personality objects, determine exactly which elements of a computer 
personality are included in a migration.  

The following sections, MS Office Support Notes and Other Support Notes, 
provide important usage notes as well as restrictions or limitations to keep in 
mind for each personality object supported in this release of CM Settings 
Migration Manager.  

Microsoft Office Supported Applications 

• Microsoft Access  95, 97, 2000, XP, 2003, 2007 

• Microsoft Excel  95, 97, 2000, XP, 2003, 2007 

• Microsoft FrontPage  2000, XP, 2003, 2007 

• Microsoft Groove 2007 

• Microsoft InfoPath  2003, 2007 

• Microsoft OneNote  2003, 2007 

• Microsoft Outlook  (Windows Messaging), 97, 98, 2000, XP, 2003, 2007 

• Microsoft PowerPoint  95, 97, 2000, XP, 2003, 2007 

• Microsoft Project  98, 2000, 2002, 2003, 2007 

• Microsoft Publisher  2003, 2007 

• Microsoft Word  95, 97, 2000, XP, 2003, 2007 

Other Supported Applications 

• Act! 2000 

• Adobe Acrobat  4.x, 5.x, 6 
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• Acrobat Reader  4.x. 5.x, 6, 7 

• MSN Messenger 7.0, 7.5 

• Yahoo Messenger 7.0, 7.5, 8 

• Lotus Notes 5.x, 6.x 

• Microsoft Internet Explorer  4.01, 5.x, 6.x, 7.x 

• Microsoft NetMeeting  2.x, 3.x 

• Microsoft Outlook Express  5.x, 6.x 

• Mozilla Firefox 1.x, 2.x 

• Netscape  4.5, 4.6, 4.7, 6.x 

• Norton AntiVirus 2000 

• Norton AntiVirus Corporate Edition 

• Visio  2000, 2002, 2003, 2007 

• WinZip  7.x, 8.x, 9.0 

• WordPerfect Office 2000 

— Corel Utilities 

— Dragon NaturallySpeaking for WordPerfect 

— Quattro Pro 9 

— WordPerfect 9 

Windows Options 

• Desktop Shortcuts 

• Dial-Up Networking 

• Folder Options 

• Local Printer Logging 

• Mapped Network Drives 

• Network and Shared Printer Connections 

• Taskbar and Start Menu 

— Quick Launch Bar Shortcuts 
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— Taskbar and Start Menu Settings 

• User Documents and Media Files 

— My Documents 

— My Pictures 

— My Music 

— My Videos 

• Windows Address Book 

Control Panel (Settings) 

• Accessibility Options 

• Display 

— Appearance and Themes 

— Background 

— Visual Effects 

• Internet Options 

• Keyboard 

— Keyboard Languages 

— Keyboard Settings 

• Mouse Settings 

— Buttons and Motions 

— Pointers and Schemes 

• Power Management 

• Regional Settings 

• Sounds 


Time Zones 
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Microsoft Office Support Notes 

Following are important usage notes to keep in mind for Microsoft Office. 

Microsoft Office 

Migrates data files, templates, and persistent settings for the following Office 
applications: 

• MS Access 

• MS Excel 

• MS FrontPage 

• MS Groove 

• MS InfoPath 

• Office Assistant Settings 

• Office Shortcut Bar 

• MS OneNote 

• MS Outlook 

• MS PowerPoint 

• MS Project 

• MS Publisher 

• MS Word 

The following versions of Office are supported 
Office 95, Office 97, Office 2000, Office XP, Office 2003 and Office 2007 

Cross version migration is supported for the following paths: 

• Office 95 to Office 97 

• Office 95 to Office 2000 

• Office 95 to Office XP 

• Office 95 to Office 2003 

• Office 97 to Office 97 

• Office 97 to Office 2000  
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• Office 97 to Office XP 

• Office 97 to Office 2003 


• Office 97 to Office 2007 


• Office 2000 to Office 2000


• Office 2000 to Office XP 

• Office 2000 to Office 2003


• Office 2000 to Office 2007


• Office XP to Office XP 

• Office XP to Office 2003 


• Office XP to Office 2007 


• Office 2003 to Office 2003


• Office 2003 to Office 2007


• Office 2007 to Office 2007


Microsoft Access 

Migrates Access data files, persistent settings, and templates. 


The following file types are migrated: 


Access Data Files 
.accda, .accdb, .accdc, .ade, .adp, .mad, .maf, .mag, .mam,
.maq, .mar, .mas, .mat, .mav, .maw, .mda, .mdb, .mdbhtml, .mde, 
.mdt, .mdw 

Access Template Files 
.accdt, .mdn, mdz, .wizhtml 

The following versions of Access are supported:

Access 95, Access 97, Access 2000, Access XP, Access 2003 and Access 2007


Cross version migration is supported for the following paths: 


• Access 95 to Access 97 


• Access 95 to Access 2000 


• Access 95 to Access XP 

• Access 95 to Access 2003


• Access 95 to Access 2007
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• Access 97 to Access 97 


• Access 97 to Access 2000


• Access 97 to Access XP 

• Access 97 to Access 2003 


• Access 97 to Access 2007


• Access 2000 to Access 2000 


• Access 2000 to Access XP 

• Access 2000 to Access 2003 


• Access 2000 to Access 2007 


• Access XP to Access XP 

• Access XP to Access 2003 


• Access XP to Access 2007 


• Access 2003 to Access 2003 


• Access 2003 to Access 2007 


• Access 2007 to Access 2007 


Microsoft Excel 

Migrates Excel data files, persistent settings, and templates. 

The following file types are migrated: 

Excel Data Files 
.csv, .dif, .dqy, .iqy, .oqy, .rqy, .slk, .thmx, .xla, .xlam,
.xlb, .xlc, .xld, .xlk, .xll, .xlm, .xls, .xlsb, .xlshtml, 
.xlsm, .xlsx, .xlv, .xlw, .xps 

Excel Template Files 
.xlt, .xltx, .xltm 

The following versions of Excel are supported:

Excel 95, Excel 97, Excel 2000, Excel XP, Excel 2003 and Excel 2007 


Cross version migration is supported for the following paths: 


• Excel 95 to Excel 97 


• Excel 95 to Excel 2000 


• Excel 95 to Excel XP 
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• Excel 95 to Excel 2003 


• Excel 95 to Excel 2007 


• Excel 97 to Excel 97 


• Excel 97 to Excel 2000 


• Excel 97 to Excel XP 

• Excel 97 to Excel 2003 


• Excel 97 to Excel 2007 


• Excel 2000 to Excel 2000


• Excel 2000 to Excel XP 

• Excel 2000 to Excel 2003


• Excel 2000 to Excel 2007


• Excel XP to Excel XP 

• Excel XP to Excel 2003 


• Excel XP to Excel 2007 


• Excel 2003 to Excel 2003


• Excel 2003 to Excel 2007


• Excel 2007 to Excel 2007


Microsoft FrontPage 

Migrates FrontPage data files, persistent settings, and templates. 

Selecting to migrate FrontPage data files will result in the migration 
of all .html and .htm files on your local disk drives unless the policies 
Exclude User's Temporary Directory and Exclude User's 
Temporary Internet Directory are set (default).  This may not be 
welcomed behavior.  If migrating all .html and .htm files is not 
desired you can use File Rules to exclude these file types entirely, or 
selectively in specified file folders on the local disk. 

The following file types are migrated: 

FrontPage Data Files 
.asa, .asp, .cdx, .fphtml, .htm, .html, .htx, .shtm, .shtml,
.stm 
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FrontPage Template Files 
.tem 

The following versions of FrontPage are supported: 
FrontPage 2000, FrontPage XP, FrontPage 2003 

Cross version migration is supported for the following paths: 

• FrontPage 2000 to FrontPage 2000 

• FrontPage 2000 to FrontPage XP 

• FrontPage 2000 to FrontPage 2003 

• FrontPage XP to FrontPage XP 

• FrontPage XP to FrontPage 2003 

• FrontPage 2003 to FrontPage 2003 

Microsoft Groove 

Migrates Groove data files and persistent settings. 

The following file types are migrated: 

Groove Data Files 
.grv, .gsa, .vcg 

The following versions of Groove are supported 

Groove 2007


Cross version migration is supported for the following paths: 

• Groove 2007 to Groove 2007 

Microsoft InfoPath 

Migrates InfoPath data files, persistent settings, and templates. 

The following file types are migrated: 

InfoPath Data Files 
.xml, .xsf 

InfoPath Template Files 
.xsn 

The following versions of InfoPath are supported 
InfoPath 2003 and InfoPath 2007 
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Cross version migration is supported for the following paths: 

• InfoPath 2003 to InfoPath 2003 

• InfoPath 2003 to InfoPath 2007 

• InfoPath 2007 to InfoPath 2007 

Office Assistant Settings 

Migrates Persistent settings for Microsoft Office Assistant. 

CM Settings Migration Manager does not migrate the specific 
assistant, only the settings associated with the office assistant. 

Office Shortcut Bar 

Migrates Persistent settings for Office Shortcut Bar. 

Microsoft OneNote 

Migrates OneNote data files and persistent settings.


The following file types are migrated: 


OneNote Data Files 
.mht, .one, .onetoc 

The following versions of OneNote are supported:

OneNote 2003 and OneNote 2007 


Cross version migration is supported for the following paths: 

• OneNote 2003 to OneNote 2003 

• OneNote 2003 to OneNote 2007 

• OneNote 2007 to OneNote 2007 

Microsoft Outlook 

Migrates Outlook data files, Outlook Mail Clients and associated files, and 
Outlook persistent settings. 
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Services on the target/injection machine must be the same as the 
services on the source/extraction machine.  For example, if the source 
machine has Outlook set to Corporate Workgroup, then Outlook on 
the target machine must also be set to Corporate Workgroup. 

The following file types are migrated: 

Outlook Files 
.ics, .msg, .oft, .pst (Inactive), .vcs 

If you migrate .pst files without selecting Outlook Mail Clients and 
Associated Files, your active .pst files will be migrated, but they will 
not be made active on the target computer. 

Outlook Mail Clients and Associated Files 
Outlook Exchange and Internet mail clients are migrated, including Windows 
messaging as an exchange client.  Active personal folders (.pst files), address 
books (.pab files), and offline address books (.oab files) are also migrated. 

The following versions of Outlook are supported

Windows Messaging, Outlook 97, Outlook 98, Outlook 2000, Outlook XP, 

Outlook 2003 and Outlook 2007 


Cross version migration is supported for the following paths: 

• Windows Messaging to Outlook 97


• Windows Messaging to Outlook 98


• Windows Messaging to Outlook 2000 


• Outlook 97 to Outlook 97


• Outlook 97 to Outlook 98


• Outlook 97 to Outlook 2000  


• Outlook 97 to Outlook XP 

• Outlook 97 to Outlook 2003 


• Outlook 97 to Outlook 2007 


• Outlook 98 to Outlook 98


• Outlook 98 to Outlook 2000  


• Outlook 98 to Outlook XP 

• Outlook 98 to Outlook 2003 


• Outlook 98 to Outlook 2007 
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• Outlook 2000 to Outlook 2000 


• Outlook 2000 to Outlook XP 

• Outlook 2000 to Outlook 2003 


• Outlook 2000 to Outlook 2007 


• Outlook XP to Outlook XP 

• Outlook XP to Outlook 2003 


• Outlook XP to Outlook 2007 


• Outlook 2003 to Outlook 2003 


• Outlook 2003 to Outlook 2007 


• Outlook 2007 to Outlook 2007 


Microsoft PowerPoint 

Migrates PowerPoint data files, persistent settings, and templates. 

The following file types are migrated: 

PowerPoint Data Files 
.pps, .ppt, .ppthtml, .pptmp, .pptx, .ppz, .pwz 

PowerPoint Template Files 
.pot, .pothtml, .potm, .potx 

The following versions of PowerPoint are supported 

PowerPoint 95, PowerPoint 97, PowerPoint 2000, PowerPoint XP, 

PowerPoint 2003 and PowerPoint 2007 


Cross version migration is supported for the following paths: 

• PowerPoint 95 to PowerPoint 97 


• PowerPoint 95 to PowerPoint 2000 


• PowerPoint 95 to PowerPoint XP 

• PowerPoint 95 to PowerPoint 2003 


• PowerPoint 95 to PowerPoint 2007 


• PowerPoint 97 to PowerPoint 97 


• PowerPoint 97 to PowerPoint 2000 


• PowerPoint 97 to PowerPoint XP 
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• PowerPoint 97 to PowerPoint 2003  


• PowerPoint 97 to PowerPoint 2007 


• PowerPoint 2000 to PowerPoint 2000 


• PowerPoint 2000 to PowerPoint XP 

• PowerPoint 2000 to PowerPoint 2003 


• PowerPoint 2000 to PowerPoint 2007 


• PowerPoint XP to PowerPoint XP 

• PowerPoint XP to PowerPoint 2003 


• PowerPoint XP to PowerPoint 2007 


• PowerPoint 2003 to PowerPoint 2003 


• PowerPoint 2003 to PowerPoint 2007 


• PowerPoint 2007 to PowerPoint 2007 


Microsoft Project 

Migrates Project data files, persistent settings, and templates. 

The following file types are migrated: 

Project Data Files 
.mpd, .mpp, .mpw, .mpx 

Project Template Files 
.mpt 

The following versions of Project are supported 

Project 98, Project 2000, Project 2002, Project 2003 and Project 2007 


Cross version migration is supported for the following paths: 

• Project 98 to Project 98 


• Project 98 to Project 2000


• Project 98 to Project 2002


• Project 98 to Project 2003


• Project 98 to Project 2007


• Project 2000 to Project 2000 


• Project 2000 to Project 2002 
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• Project 2000 to Project 2003 


• Project 2000 to Project 2007 


• Project 2002 to Project 2002 


• Project 2002 to Project 2003 


• Project 2002 to Project 2007 


• Project 2003 to Project 2003 


• Project 2003 to Project 2007 


• Project 2007 to Project 2007 


Microsoft Publisher 

Migrates Publisher data files and persistent settings. 

The following file types are migrated: 

Publisher Data Files 
.pub, .pubhtml, .pubmhtml 

The following versions of Publisher are supported

Publisher 2003 and Publisher 2007 


Cross version migration is supported for the following paths: 

• Publisher 2003 to Publisher 2003 


• Publisher 2003 to Publisher 2007 


• Publisher 2007 to Publisher 2007 


Microsoft Word 

Migrates Word data files, persistent settings, and templates. 

The following file types are migrated: 

Word Data Files 
.doc, .dochtml, .docm, .docx, .gly, .rtf, .wbk, .wiz 

Word Template Files 
.dot, .dothtml, .dotm, .dotx 

The following versions of Word are supported:

Word 95, Word 97, Word 2000, Word XP, Word 2003 and Word 2007 
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Cross version migration is supported for the following paths: 

• Word 95 to Word 97 


• Word 95 to Word 2000 


• Word 95 to Word XP 

• Word 95 to Word 2003 


• Word 95 to Word 2007 


• Word 97 to Word 97 


• Word 97 to Word 2000 


• Word 97 to Word XP 

• Word 97 to Word 2003 


• Word 97 to Word 2007 


• Word 2000 to Word 2000


• Word 2000 to Word XP 

• Word 2000 to Word 2003


• Word 2000 to Word 2007


• Word XP to Word XP 

• Word XP to Word 2003 


• Word XP to Word 2007 


• Word 2003 to Word 2003


• Word 2003 to Word 2007


• Word 2007 to Word 2007


Other Supported Application and Operating System 
Notes 

Following are important usage notes to keep in mind for each content item 
included in this release of CM Settings Migration Manager.   
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Act! 2000 

Migrates ACT! 2000 persistent settings and ACT! 2000 files. 


The following file types are migrated: 


ACT! 2000 Files 
.adt, .cly, .env, .gly, .lbl, .mpr, .rep, .rpt, .tpl, .usr,
.wpa 

ACT! 2000 Database Files 
.dbf, .adb, .adx, .blb, .ddb, .ddf, .ddx, .edb, .edx, .gdb,
.gdx, .hdb, .hdx, .lck, .mdx, .rel, .rem, .rex, .sdb, .sdx,
.tdb, .tdx 

Adobe Acrobat 

Migrates Adobe Acrobat files and persistent settings for Adobe Acrobat and 
Adobe Acrobat Reader. 

The following file types are migrated: 

Adobe Acrobat Data Files 
.akf, .apf, .eps, .fdb, .fdf, .joboptions, .ndx, .p7c, .pdf,
.pdx, .pfx, .ps, .sequ 

The following versions of Adobe Acrobat are supported 
Acrobat Reader 4.x, Acrobat Reader 5.x, Acrobat Reader 6.x, Acrobat Reader 
7.x, Adobe Acrobat 4.x, Adobe Acrobat 5.x, Adobe Acrobat 6.0. 

Cross version migration is supported for the following paths: 

• Adobe Acrobat 4.x to 4.x 

• Adobe Acrobat 4.x to 5.x 

• Adobe Acrobat 4.x to 6.0 

• Adobe Acrobat 5.x to 5.x 

• Adobe Acrobat 5.x to 6.0 

• Adobe Acrobat 6.0 to 6.0 

• Acrobat Reader 4.x to 4.x 

• Acrobat Reader 4.x to 5.x 

• Acrobat Reader 4.x to 6.x 

• Acrobat Reader 4.x to 7.x 
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• Acrobat Reader 5.x to 5.x 

• Acrobat Reader 5.x to 6.x 

• Acrobat Reader 5.x to 7.x 

• Acrobat Reader 6.x to 6.x 

• Acrobat Reader 6.x to 7.x 

• Acrobat Reader 7.x to 7.x 

MSN Messenger 

Migrates locally stored, unencrypted settings. 

The following versions of MSN Messenger are supported 

MSN Messenger 7.0 and MSN Messenger 7.5 


Cross version migration is supported for the following paths: 


• MSN Messenger 7.x to 7.x 

Yahoo Messenger 

Migrates account Username, Password, and locally stored settings. 

The following versions of Yahoo Messenger are supported 
Yahoo Messenger 7, Yahoo Messenger 7.5, Yahoo Messenger 8 

Cross version migration is supported for the following paths: 

• Yahoo Messenger 7.x to Yahoo Messenger 7.x 

• Yahoo Messenger 7.x to Yahoo Messenger 8 

• Yahoo Messenger 8 to Yahoo Messenger 8 

Lotus Notes 5.x, 6.x 

Migrates Lotus Notes data files and persistent settings. Only user ID files in 
the default location and the last used user ID file are migrated. 

If the migration of user ID files stored in non-default locations is 
desired this can be accomplished using CM Settings Migration 
Manager File Rules. 
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Cross version migration is supported for the following paths: 

• Lotus Notes 5.x to Lotus Notes 5.x 

• Lotus Notes 5.x to Lotus Notes 6.x 

• Lotus Notes 6.x to Lotus Notes 6.x 

Microsoft Internet Explorer 

Migrates Internet Explorer persistent settings, cookies, proxy settings, and 
favorites. 

The following versions of Internet Explorer are supported:

IE 4.01, IE 5.x, IE 6.x, IE 7.x 


Cross version migration is supported for the following paths: 

• IE 4.01 to IE 4.01 

• IE 4.01 to IE 5.x 

• IE 4.01 to IE 6.x  

• IE 4.01 to IE 7.x 

• IE 5.x to IE 5.x 

• IE 5.x to IE 6.x 

• IE 5.x to IE 7.x 

• IE 6.x to IE 6.x 

• IE 6.x to IE 7.x 

• IE 7.x to IE 7.x 

Microsoft NetMeeting 

Migrates Microsoft NetMeeting settings. 


The following file types are migrated: 


NetMeeting Whiteboard Files 
.nmw, .wht 

The following versions of Microsoft NetMeeting are supported 
Microsoft NetMeeting 2.x, Microsoft NetMeeting 3.x 

Cross version migration is supported for the following paths: 
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• Microsoft NetMeeting 2.x to Microsoft NetMeeting 2.x 

• Microsoft NetMeeting 2.x to Microsoft NetMeeting 3.x 

• Microsoft NetMeeting 3.x to Microsoft NetMeeting 3.x 

Microsoft Outlook Express 

Migrates Microsoft Outlook Express persistent settings, Windows Address 
Book, mail, and news files. 

The following file types are migrated: 


Outlook Express Files 

.eml, .nws, Outlook Express Stationery 


The following versions of Microsoft Outlook Express are supported:

Outlook Express 5.x, Outlook Express 6.x 


Cross version migration is supported for the following paths: 


• Microsoft Outlook Express 5.x to Microsoft Outlook Express 5.x 

• Microsoft Outlook Express 5.x to Microsoft Outlook Express 6.x 

• Microsoft Outlook Express 6.x to Microsoft Outlook Express 6.x 

Mozilla Firefox 

Migrates Mozilla Firefox persistent settings, files, bookmarks, cookies, 
extensions. 

The following versions of Mozilla Firefox are supported 

Firefox 1.x, 2.x 


Cross version migration is supported for the following paths: 

• Firefox 1.x to 1.x 

• Firefox 1.x to 2.x 

• Firefox 2.x to 2.x 

Netscape 

Migrates Netscape data files and persistent settings 
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The following versions of Netscape Communicator are supported: 
Netscape 4.5, Netscape 4.6, Netscape 4.7, and Netscape 6.x 

Cross version migration is supported for the following paths: 

•	 Netscape 4.5 to Netscape 4.5 

•	 Netscape 4.5 to Netscape 4.6 

•	 Netscape 4.5 to Netscape 4.7 

•	 Netscape 4.5 to Netscape 6.x 

•	 Netscape 4.6 to Netscape 4.6 

•	 Netscape 4.6 to Netscape 4.7 

•	 Netscape 4.6 to Netscape 6.x 

•	 Netscape 4.7 to Netscape 4.7 

•	 Netscape 4.7 to Netscape 6.x 

•	 Netscape 6.x to Netscape 6.x 

Norton Antivirus 

Migrates Persistent settings for Norton AntiVirus 

The following versions of Norton AntiVirus are supported:

Norton AntiVirus 2000 


Norton AntiVirus Corporate Edition 

Migrates custom scans and user settings for Norton AntiVirus Corporate 
Edition. 

The following versions of Netscape Communicator are supported 
Norton AntiVirus Corporate Edition 7.6 and Symantec AntiVirus Corporate 
Edition 8.0. 

Cross version migration is supported for the following paths: 

•	 Norton AntiVirus Corporate Edition 7.6 to Norton AntiVirus Corporate 
Edition 7.6 

•	 Norton AntiVirus Corporate Edition 7.6 to Symantec AntiVirus Corporate 
Edition 8.0 
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•	 Symantec AntiVirus Corporate Edition 8.0 to Symantec AntiVirus 
Corporate Edition 8.0 

Visio 

Migrates Visio data files, persistent settings and templates. 


The following file types are migrated: 


Visio Data Files 
.vdx, .vrd, .vsd, .vss, .vsw, .vsx 

Visio Template Files 
.vst, .vtx 

The following versions of Visio are supported 

Visio 2000, Visio 2002, Visio 2003 and Visio 2007 


Cross version migration is supported for the following paths: 

•	 Visio 2000 to Visio 2000 


•	 Visio 2000 to Visio 2002 


•	 Visio 2000 to Visio 2003 


•	 Visio 2000 to Visio 2007 


•	 Visio 2002 to Visio 2002 


•	 Visio 2002 to Visio 2003 


•	 Visio 2002 to Visio 2007 


•	 Visio 2003 to Visio 2003 


•	 Visio 2003 to Visio 2007 


•	 Visio 2007 to Visio 2007 


WinZip 

Migrates WinZip data files and persistent settings 

WinZip content does not migrate .cab files by design.  If the migration 
of .cab files is desired this can be accomplished using CM Settings 
Migration Manager File Rules. 

The following file types are migrated: 
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WinZip Files 
.arc, .arj, .b64, .bhx, .gz, .hqx, .lzh, .mim, .tar, .taz,
.tgz, .tz, .uu, .uue, .xxe, .z, .zip 

The following versions of WinZip are supported:

WinZip 7.x, WinZip 8.x, WinZip 9.0 


Cross version migration is supported for the following paths: 

• WinZip 7.x to WinZip 7.x 

• WinZip 7.x to WinZip 8.x 

• WinZip 7.x to WinZip 9.0 

• WinZip 8.x to WinZip 8.x 

• WinZip 8.x to WinZip 9.0 

• WinZip 9.0 to WinZip 9.0 

WordPerfect Office 2000 

Word Perfect Office 2000 will migrate data files, templates, and persistent 
settings for the following applications:  

• Corel Utilities (Address Book & QuickFinder) 

• Dragon NaturallySpeaking for WordPerfect 3.x, and 4.x 

• Quattro Pro 9.0 

• WordPerfect 9.0


The following versions of WordPerfect Office are supported:


• WordPerfect Office 2000


Cross version migration is supported for the following paths: 


• WordPerfect Office 2000 to WordPerfect Office 2000


Dragon NaturallySpeaking For WordPerfect 

Migrates Dragon NaturallySpeaking data files and persistent settings. 

The following versions of Dragon NaturallySpeaking are supported: 
Dragon NaturallySpeaking 3.x, Dragon NaturallySpeaking 4.x 

Cross version migration is supported for the following paths: 
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• Dragon NaturallySpeaking 3.x to Dragon NaturallySpeaking 3.x 

• Dragon NaturallySpeaking 3.x to Dragon NaturallySpeaking 4.x 

• Dragon NaturallySpeaking 4.x to Dragon NaturallySpeaking 4.x 

Corel Utilities 

Corel Address Book 
Migrates persistent settings and data files for Corel Address Books 

Corel QuickFinder 
Migrates settings for Corel Office 2000 Suite QuickFinder. 

Corel Quattro Pro 

Migrates Quattro Pro data files and persistent settings 


The following file types are migrated: 


Quattro Pro 9 Data Files 
.qpw, .wb1, .wb2, .wb3, .wq1 

Corel WordPerfect 

Migrates WordPerfect data files and WordPerfect persistent settings 

The following file types are migrated: 

WordPerfect 9 Data Files 
.frm, .lab, .usr, .wpd, .wpt 

Data Transport 

Migrates files and registry values as set in File Rules, File Tree, and Registry 
Rules. 
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Windows Options 


Migrates persistent settings and files for:  Control Panel, Desktop 
Shortcuts, Dial-up Networking, Folder Options, Local Printer Logging, 
Mapped Network Drives, Network and Shared Printer Connections, Taskbar 
and Quick Launch Bar, User Documents and Media Files, Windows Address 
Book. 

Desktop Shortcuts 

• Migrates shortcuts on the desktop. 

Desktop shortcuts that have broken links are not migrated by default. 
For example, if there is a shortcut to an installed application on the 
source machine's desktop but that application is not installed on the 
target machine, the shortcut will not be migrated because it would 
have become a broken link on the target machine. To migrate broken 
link files select Preferences from the Edit menu and check the Broken 
Shortcut Policy check box. The broken link files will be migrated to 
the source directory and placed in a folder named “Broken Shortcuts”. 

Dial-Up Networking 

Migrates persistent settings and files for dial-up networking. 

Persistent settings that are hardware related are not migrated by 
design. 

Folder Options 

Migrates persistent settings for folder options. 

Local Printer Logging 

A file named printinfo.txt is created during injection on the users desktop 
that contains Printer information for both network and local printers. 
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Mapped Network Drives 

Migrates mapped network drives. If on the target machine a drive letter is in 
use that is the same as a mapped drive being migrated, the next available 
drive letter will be used for the migrated network drive. 

Hardware related settings and files are not migrated by design. 

Network and Shared Printer Connections 

Migrates networked and shared printers. Printers are migrated if they have a 
valid UNC path and are accessible via the network or via a share. When 
printers are migrated a printer icon is placed on the target system's desktop. 
Double clicking on this icon will install the printer.  

The CM Settings Migration Manager Operator must have full access 
to the printers being migrated for each user. Hardware related 
settings and files are not migrated by design. 

Taskbar and Quick Launch Bar 

Migrates Start Menu settings, Taskbar settings and Quick Launch Bar 
shortcuts. 

User Documents and Media Files 

Migrates the contents of My Documents, My Pictures, My Music, and My 
Videos. 

My Documents 

Migrates the contents of My Documents 

If the My Documents folder is renamed or the location changed, CM 
Settings Migration Manager will still recognize this folder as "My 
Documents" and the contents of the folder will migrate to the "My 
Documents" folder on the target system. 
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My Music 

Migrates the contents of My Music 

My Pictures 

Migrates the contents of My Pictures 

My Videos 

Migrates the contents of My Videos 

Windows Address Book 

Migrates the windows address book. 

Control Panel 

Hardware related settings and files are not migrated by design 

Migrates Persistent settings and files for: 

Accessibility Options, Display, Internet Options, Keyboard, Mouse Settings,

Power Management, Regional Settings, Sounds, and Time Zones. 


Accessibility Options 

Migrates keyboard, sound, display, and mouse accessibility settings 

Display 

Migrates appearance and themes, background, and visual effects 
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Internet Options 

Migrates Internet properties (home page, colors, fonts, languages) 

Keyboard 

Migrates Keyboard Languages and Keyboard Settings. Keyboard Languages 
are stored in different places and named differently, depending upon the 
operating system installed. 

On Windows 2000, the settings are stored under the following path: 
Control Panel \ Keyboard \ Input Locales (tab). 

The settings can also be found under the following path for Windows 2000: 
Control Panel \ Regional Settings \ Input Locales. 

On Windows XP Pro, the settings can be found under the following path: 
Control Panel \ Regional and Language Options \ Languages (tab)
\ Details [Button] 

On Windows Vista, the settings can be found under the following path: 
Control Panel \ Clock, Language, and Region \ Change keyboards
or other input methods \ Change keyboards [Button] 

Mouse Settings 

Migrates Persistent settings and files for Mouse (buttons, motion, pointers, 
and schemes). 

Power Management 

Migrates Persistent settings for Power Management. 

Regional Settings 

Migrates Persistent Regional Settings. 

If Country Codes between different Operating System Versions have 
changed or the Country Code is not present on the target machine the 
settings will not migrate. 
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Sounds 

Migrates persistent settings and files for Windows system sounds. 

Time Zones 

Migrates persistent settings for Time Zones 
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